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Introduction 
 

This document contains exercises consisting of step-by-step instructions of particular 
customizations that can be performed using EDEX and/or CAVE.  These instructions build upon 
the concepts presented in the AWIPS-2 Overview, the EDEX Overview, and the CAVE Overview 
modules.  To help you understand the procedures, each exercise has a background section to 
provide objectives, context, and the reasoning or strategy behind the instructions.  To help you 
apply the instructions to additional situations, the instructions are divided into concepts and 
actions.  The concepts describe the basic procedure and the actions provide the series of steps 
to follow. 

Document Conventions: 

These instructions employ a few conventions that are intended to help you distinguish various 
typed commands and options.   

When a command is to be typed at a terminal prompt, it is written in a bold Courier 
(monospaced) font, and each new line of input begins with a dollar prompt ($).  In some of these 
lines, long commands may wrap to multiple lines on the page, but you should enter every 
command that begins with a $ prompt on one line.  In this example, there are two commands: 

$ cd /awips2/static/database.maps 
$ ./importShapeFiles.sh /home/awips/shapes/urban_bounds.shp mapdata urbanbounds 
0.064,0.016,0.004,0.001 awips  

When the document references a keyword which may require you to substitute your own 
information, it is written using curly braces {} and a gray background. For example, the section 
of the Localization Store that contains some of your site’s override files is often referenced as 
cave_static/site/{your site}/bundles/.  Thus, if your site is Wichita, you would substitute ICT for 
{your_site}, so the directory path would be cave_static/site/ICT/bundles/. 

In most cases, this document references machines by their logical function rather than by their 
name.  For example, it mentions {edex_server} rather than DX3 or {database_server} rather 
than DX1.  This was done to help make these exercises a bit more portable as well as to survive 
potential changes to the AWIPS-2 hardware architecture.  For more information on the 
functions of particular machines, you might wish to consult the AWIPS-2 System Managers 
Manual or the AWIPS-2 System Administration training course materials.  

Note:  Exercises 1,3, and 4 suggest using a few external files for an urban boundaries shapefile, 
another WFO’s scale maps, and some spotters.dat files.  An ExerciseResources.zip file alongside this 
PDF contains sample files in case you cannot obtain your own files.  
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Exercise 1:  Maps — Import Urban Boundaries Shapefile 
 
Objectives:  In this exercise, you will perform the following procedures: 

• Import a new geographic shapefile into the AWIPS-2 maps database. 
• Create a display bundle for the new shapefile, so it is displayable from the Maps menu 

of the D2D perspective in CAVE. 
• Optionally add constraints to filter the shapefile data prior to display.   

Background.  AWIPS-2 uses the PostGIS extension to the PostgreSQL database to manage many 
of the map backgrounds.  In this design, shapefiles are actually loaded into the Maps database 
and are not directly accessed from files.  One benefit from this approach is that AWIPS-2 can 
access attributes in the shapefiles that AWIPS-1 ignored.  Both 
Exercise 1 and Exercise 2 illustrate how to use these attributes. 

AWIPS-1 had a User Shapefile capability where you could simply 
rename up to 3 vector shapefiles and 2 point shapefiles to 
userFile#.shp, userFile#.shx and userFile#.dbf, where # was 1 
through 5, and place these files in $FXA_HOME/data or in your 
localizationDataSets/$FXA_LOCAL_SITE.  While the User Shapefile 
function does not exist in AWIPS-2, two methods do exist to access 
shapefiles in AWIPS-2.  The first method, described in this exercise, 
adds the shapefile to the database and the Maps menu.  The second 
method, the Import GIS data function accessible from the CAVE menu, interactively accesses 
shapefiles from disk.  This second process is described in the AWIPS-2 Variance Training 
modules.     

This exercise steps you through importing your own shapefiles into the AWIPS-2 Maps 
database.  The specific example uses an urban boundaries shapefile from AWIPS-1 called 
urbanBounds.   In particular, this exercise uses the importShapeFile.sh script that’s located in 
/awips2/database/sqlScripts/share/sql/maps/ on your database server (normally DX1).  The 
arguments for importShapeFile.sh are: 
 
importShapeFile.sh shapefile schema table simplev dbUser  

For a complex shapefile, running the importShapeFile.sh script may take several minutes.  
(Note:  some large FFMP shapefiles have resulted in out of memory errors; the AWIPS Network 
Control Facility can provide assistance in this situation, because it requires temporarily 
adjusting certain settings in the database itself.)  After importing the shapefile, we need to 
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create a display bundle and make the map accessible from the maps menu.  We’ll use the 
Localization Perspective for part of these steps. 

This exercise will take 30 minutes or less to complete. 

 

Concept Actions 

Part 1:  Import Urban Bounds Shapefile 
1. Place the urbanBounds shapefiles 

someplace accessible by DX1 or DX2.  
You would probably obtain the 
shapefiles from AWIPS-1 or the 
NOAA1 ftp server. 

In this example, the three files that make up the 
urbanBounds shapefile are located in 
/home/awips/shapes on the database server: 

• /home/awips/shapes/urban_bounds.shp 
• /home/awips/shapes/urban_bounds.shx 
• /home/awips/shapes/urban_bounds.dbf 

2. Import the shapefile into the 
database.   

On the database server (DX1), open a terminal 
window as the awips user.  Go to the directory that 
contains the importShapeFile.sh script and run the 
import script.  The new map database table will be 
called mapdata.urbanbounds.  The 
importShapeFile.sh command below is to be typed on 
one single line. 
 
$ cd /awips2/database/sqlScripts/share/sql/maps 
$ ./importShapeFile.sh 
/home/awips/shapes/urban_bounds.shp mapdata 
urbanbounds 0.064,0.016,0.004,0.001 awips  
  

Note that /home/awips/shapes/urban_bounds.shp in 
the command above needs to refer to the location of 
your shapefile. 
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3. Create a site-level urban.xml bundle 
starting with the base-level 
counties.xml bundle.   

 
Note:  Before attempting to create a 
SITE-level configuration file, the user 
performing the configuration must have 
permissions enabled in the 
userRoles.xml file.  For example, this 
new entry was added to a site override 
version of userRoles.xml located in 
common_static/site/OAX/roles/ 
userRoles.xml to enable the user 
“dmorris” to make site-level 
configuration changes.  

 

In the Localization 
Perspective file 
browser, open CAVE 
» Bundles » maps » 
Counties.xml.  Right-
click the BASE icon 
then  
Copy To ►New 
File...  Call the new 
file urban.xml.  
 
The new urban.xml 
file probably 
defaulted as a new 
user-level file.  We 
want this to be a 
site-level override, 
so right-click the 
new USER icon 
under urban.xml 
and click Move To ►Site. 

4. Make edits to urban.xml.  Change the 
table name from mapdata.county to 
mapdata.urbanbounds and the menu 
entry label from County Boundaries 
to Urban Boundaries.  

In the Localization Perspective 
file browser, navigate to your 
new urban.xml file (it’s possible 
that the file browser has 
automatically navigated there 
for you).  It should appear 
under CAVE » Bundles » maps.  
When you find urban.xml, open 
it and edit the new SITE version 
you just created by double-clicking on it.  Click on the 
Source tab at the bottom of the editor window to edit 
the XML. 
 
Make these edits to the ResourceData tag (shown in 
Figure 1), and the save urban.xml file when you’re 
finished. 

• Change the table to mapdata.urbanbounds 
• Change the mapName to Urban Boundaries 
• Delete the two lines indicated by the red box 

in Figure 1. 
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Figure 1.  Edits to urban.xml 
 
5. Restart CAVE and load the new 

urban boundaries in the D2D 
perspective.  The Maps menu is 
unusual in that CAVE dynamically 
builds the menu when CAVE starts 
up by scanning bundles in 
/awips2/cave/etc/bundles/maps or 
in the Localization Store in 
bundles/maps in cave_static under 
site, user, or workstation. 
 

Click the 
Maps menu 
and load 
Urban 
Boundaries.   
 

Part 2:  Add Optional Constraints 
6. Optional:  Add constraints based on 

shapefile attributes.  Open the 
urbanbounds table in pgadmin3 so 
you can see the attributes and their 
datatypes.  You need to know the 
datatypes so you can make the 
appropriate queries with correct 
syntax.  

 
NOTE:  Beginning with OB13.4, an AWIPS-2 
version of pgadmin3, a graphical interface 
for PostgreSQL, has been distributed as an 
RPM (awips2-pgadmin3).  Once installed 
on your system, this version of pgadmin3 
can be started in a terminal window using 
/awips2/pgadmin3/bin/pgadmin3. 

Start pgadmin3.  Open the maps database.  Open the 
mapdata schema.  Open the Tables tab and navigate 
to urbanbounds.  Click on the view table icon.  An 
excerpt of the urbanbounds table is shown in Figure 
2. 
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Figure 2.  Excerpt of urbanbounds table in the maps database. 
 
7. Optional: Add constraints based on 

the OAX CWA and these neighboring 
CWAs:  OAX, FSD, DMX, EAX, TOP, 
GID, LBF.  In this case we used single 
quotes around the CWAs because 
they are character fields.  Exercise 2 
will show another example of 
adding a constraint. 

Re-open the localization perspective and navigate to 
urban.xml and edit it.  Add the following constraint to 
the end of the same resourceData we edited above: 
 
<constraint> 
cwa in 
(’OAX’,’FSD’,’DMX’,’EAX’,’TOP’,’GID’,’LBF’) 
</constraint> 
 

This entry should be on one line to match the 
structure of the rest of the XML file (as shown in 
Figure 3).  There’s no need to add the line breaks that 
were added here for clarity.  Also see how the 
Localization Perspective editor automatically adds 
closing tags, closing parenthesis, and closing quote 
marks for your convenience. 

 



CAVE/EDEX Step-By-Step Exercises Exercise 1: Import Shapefiles  7 

 
Figure 3.  Final edits to urban.xml to add cwa constraint. 
 

8. Optional: Switch to the D2D 
perspective and reload the Urban 
Boundaries map.  It’s not necessary 
to restart CAVE here because we are 
not modifying the menu in any way 
in this step. 
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Exercise 2:  Maps — Database Constraints 
Cities with Population > 25,000 

Objectives:  In this exercise, you will perform these procedures: 

• Create a display bundle that pulls city locations from the maps database 
• Add a constraint to the database query to limit the cities to those with population 

greater than 25,000. 

Background.  As illustrated at the end of Exercise 1, AWIPS-2 can access various attributes 
included in shapefiles to filter the display. Map bundles can include various constraints to limit 
the data as it is queried from the database.   

In this example, we’re going to create a user-level map bundle to display city locations, but only 
for cities with populations over 25,000.  We can do this because the baseline maps database 
contains a city table that includes a number of attributes, including population.  The normal 
Cities overlay in the Maps menu uses this database table.   You can verify this yourself by 
looking at the following bundle file:  /awips2/cave/etc/bundles/maps/Cities.xml.  You can look 
at this file using the Localization Perspective by navigating the file browser to CAVE » Bundles » 
maps » Cities.xml and opening the BASE file.  So to do this task, we’ll start with the cities.xml 
file and make the necessary modifications for a new bundle to plot cities over 25,000 
population. 

 

This exercise will take about 15 minutes or less to complete. 

 

 Troubleshooting Tip    

Earlier builds of AWIPS-2 implemented the cities overlay using the cities.lpi file (in /awips2/cave/etc/basemaps) 
rather than using the cities table in the database.   So in the earlier versions, the cities displayed on the map could be 
changed simply by editing the cities.lpi file.  Current builds still include the cities.lpi file but because the display 
bundle references the database rather than cities.lpi, different methods would be used to modify the cities on the 
map.  When making modifications in AWIPS-2 configurations, it is a good practice to verify whether or not the 
default CAVE display bundles have changed, especially when multiple methods exist that generate similar displays.  
 
Note:  In the previous versions, the bundle which used cities.lpi had a resourceData tag of  
xsi:type=“lpiResourceData”.  The database version uses xsi:type=“ dbPointMapResourceData”.  Other bundles 
utilizing dbPointMapResourceData were found in the FAA directory. 



CAVE/EDEX Step-By-Step Exercises Exercise 2: Maps Database Constraints  9 

 Concept Actions 

1. Create a user-level 
cities25k.xml 
bundle starting 
with the base-level 
cities.xml bundle   

In the Localization Perspective file browser, open CAVE » Bundles » 
maps » Cities.xml.  Right-click BASE and Copy To ► New File…  Call the 
new file cities25k.xml. 

 
2. Make edits to 

cities25k.xml.  
Change the menu 
entry label from 
Cities to Cities &gt; 
25,000  

In the Localization Perspective file 
browser, navigate to your new 
cities25k.xml file.  It should appear under 
CAVE » Bundles » maps.  When you find 
cities25k.xml, open it, and edit the new 
user version by double-clicking on it.  Click 
on the Source tab at the bottom of the 
editor window to edit the XML. 
 
Make this edits to the ResourceData tag (shown in Figure 1), and the 
save cities25k.xml file when you’re finished. 

• Change the mapName to Cities &gt;25,000 
We use &gt; for the > symbol in the mapName tag to not interfere with 
the syntax of the XML that also uses < and > to delimit tags. 
 
Save your changes. 
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Figure 1.  Edits to cities25k.xml. 
 

3. Restart CAVE and 
load the new  
Cities >25,000 map 
in the D2D 
perspective.  Of 
course, at this 
stage, the bundle 
has no constraints, 
so all cities in the 
database table are 
displayed, subject 
to progressive 
disclosure. 

Click the Maps menu and load Cities > 25,000.  

 
 

4. Add constraints 
based on the 
population 
attribute.  Open the 
city table in 
pgadmin3 so you 
can see the 
attributes and their 
datatypes.  You 
need to know the 
datatypes so you 
can make the 

Start pgadmin3.  Open the maps database.  Open the mapdata schema.  
Open the Tables tab and navigate to city.  Click on the view table icon.  
An excerpt of the city table is shown in Figure 2. 
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appropriate queries 
with correct syntax.  

 
 

 
Figure 2.  Excerpt of the city table in the maps database. Notice that population is stored as a 
character field, and also that a few locations in the District of Columbia have a decimal point in 
the population field.   
 
5. Add a constraint 

based on the 
population field.  
 
Normal intuition 
would suggest the 
constraint to be 
population > 
25000.  Because 
the datatype is 
character, the field 
needs to be 
typecast to a 
numeric field; 
otherwise the 
filter would be 
done in an 
alphabetic sense 
rather than 
numerical.  Also, 

Re-open the localization perspective and navigate to cities25k.xml and 
edit it.  Add the following constraint to the end of the resourceData we 
edited above (shown in Figure 3): 
 
<constraint> population not like ‘%Null%’ and 
population::numeric &gt; 25000 </constraint> 
 

The first part of the constraint (population not like ‘%Null%’) filters out 
several records where the population field contains the string “<Null>”.  
This filter is required to prevent the inline conversion of the character 
field to number (described below) from failing on these values.  
 
The double colon notation does an inline conversion of the character 
data to numeric before doing the comparison.  Had we not done the 
typecast, the (incorrect) constraint should have read population &gt; 
‘25000’ to be syntactically correct because of the character datatype. 
 
 
 
Save your changes. 
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the numeric 
typecast in this 
case takes care of 
the decimal 
values; an integer 
typecast generates 
an exception when 
encountering a 
decimal point. 

 

 
Figure 3.  cities25k.xml with the population constraint. 
 

6. Switch to the D2D 
perspective and 
reload the  
Cities > 25,000 
map.   
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Exercise 3:  Maps — Spotter Readout Data and Other Adaptive Plots 
 

Objective:  In this exercise, you will perform the following procedure: 

• Import a properly-formatted text file to enable the spotter readout functionality.  

Background.  In AWIPS-1, the spotter readout map was created 
by having a spotters.dat text file in your $FXA_CUSTOM_FILES 
and running a –station localization with mainScript.csh.  This 
localization step created a special netCDF file that contained the 
spotter information.  In addition, AWIPS-1 harnessed the same 
infrastructure to allow other types of data to be displayed in a 
similar fashion, so long as the text .DAT file was formatted 
correctly and the proper data keys were created. 

 

AWIPS-2 contains the importAdaptivePlot.py command-line script located in /awips2/fxa/bin.  
The arguments for importAdaptivePlot.py are 

importAdaptivePlot.py –f {path_to_file.dat} –s edex_host_name:9581/services –n ‘Menu 
Name’  

When this command runs, the .dat file is uploaded to the EDEX server and is stored in the Utility 
Tree under cave_static/configured/{SITE}/basemaps/adaptivePlots.  A corresponding display 
bundle is created and written to cave_static/configured/{SITE}/bundles/maps.  Occasionally, 
edits to either the bundle or the .dat file may be required to enable the functionality to work, 
but the edits can be performed in the localization perspective.  These situations are covered 
below. 

NOTE:  AWIPS-2 expects the file format for the .dat file to be exactly like the example shown 
above, except that it wants the address field to not be abbreviated, so it is like 
“spotterAddress”, or “coopAddress”.  There should not be any blank lines between any of the 
fields in any one spotter entry, but there can be blank lines between individual entries.  Some 
editing of existing .dat files may be required to make them conform to the AWIPS-2 
expectations.  This editing can be done after the files are imported to the EDEX server using the 
localization perspective.  Alternatively, the files can be edited using any other text editor prior 
to uploading them to the EDEX server.  AWIPS-2 also expects the field name to match the 
filename (so that field names like venueName must be in a venue.dat file and not venues.dat) 
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This exercise should take about 10 minutes to complete. 

 

Concept Actions 

1. Locate your 
spotters.dat 
file and place it 
in an accessible 
location on an 
AWIPS-2 
workstation.   

In this example, the spotters.dat file is located at 
/home/awips/spotters.dat. 

 

2. Upload the 
spotters.dat 
file to the EDEX 
server. 

On your CAVE workstation, open a terminal window and go to the 
directory that contains the importAdaptivePlot.py script and run it.  This 
script can need not be run by the awips user. The importAdaptivePlot.py 
command below needs to be typed on one single line, and {edex_server} 
refers to the machine name of your EDEX server (normally DX3 or EC if an 
operational AWIPS machine). 
 
$ cd /awips2/fxa/bin 
$ ./importAdaptivePlot.py -f /home/awips/spotters.dat –s 
{edex_server}:9581/services –n “Spotters Readout” 

3. Inspect the 
bundle and the 
data file to 
ensure 
consistency. 

 
NOTE:  later 
versions of the 
importAdaptive 
Plot.py script 
corrects for some 
of the data 
inconsistencies if 
the input file is 
spotters.dat.  It still 
a good idea to 
check the file, and 
is absolutely 
necessary if the 
adaptive plot is 
something other 
than spotters.dat. 

In the Localization Perspective, open the 
spotters.xml bundle by clicking CAVE » 
Bundles » maps » spotters.xml, and then 
double-clicking CONFIGURED.  This file is 
shown in Figure 1.  There is also a BASE 
version of spotters.xml, and it’s explained 
below in a Troubleshooting Tip.   Notice the value of the name tag.  If you 
used “spotters.dat” in Step 2, this value should be “spotters” because it 
comes from the filename.  If the file were coop.dat, the name would be 
“coop”.  This name must be consistent with the field names in the .dat 
file. 
 
Open the spotters.dat file by clicking CAVE » Basemaps » adaptivePlots » 
spotters.dat, and double-clicking on CONFIGURED.  An excerpt of a 
sample (and redacted) spotters.dat file is shown in Figure 2.  In this case, 
the data fields are named spotterName, spotterAddr, spotterCity, and 
spotterPhone.   
 
This file has two problems.  Because the value of name in the bundle is 
“spotters”, CAVE expects these field names to be spottersName, 
spottersAddress, spottersCity, and spottersPhone.  To fix these issues, we 
can change the bundle to say “spotter” rather than “spotters”, and we 
can change the spotters.dat file to say “spotterAddress”, rather than 
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“spotterAddr”. If the original file was named “spotter.dat”, rather than 
“spotters.dat”, then the only issue would be “Address” vs “Addr”. 
 
Admittedly, in this exercise, “spotters” vs “spotter” is extremely 
confusing.  Remember that if the filename that is passed into 
importAdaptivePlot.py is spotter.dat, then the field names would be 
spotterName and spotterAddress.  If the filename is spotters.dat, then the 
field names need to be spottersName and spottersAddress. 

 
Figure 1.  CONFIGURED version of spotters.xml after uploading spotters.dat file to EDEX server using 
importAdaptivePlots.py. 
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Figure 2.  Sample spotters.dat file. 

4. Fix the 
spotters.xml 
bundle by 
making a site-
level override. 

In the Localization Perspective, 
click on the tab containing  the 
CONFIGURED spotters.xml.  If 
you have the Link with Editor 
button enabled, the file 
browser should automatically 
reposition itself with the 
CONFIGURED version of spotters.xml highlighted.  Right-click on 
CONFIGURED and choose Copy To ►Site. 
Double-click the new SITE version of spotters.xml and change the tag from 
name=“spotters” to name=“spotter” in the SITE version and save the 
changes. 
 

5. Fix the 
spotters.dat 
file using a site 
override 
version. 

In the Localization Perspective, 
click on the tab containing  the 
CONFIGURED spotters.dat.  The 
file browser should 
automatically reposition itself 
with the CONFIGURED version of 
spotters.dat highlighted.  Right-
click on CONFIGURED and 
choose Copy To ►Site.  It’s possible or likely AlertViz may be flooded with 
messages that can be ignored, but will have to be acknowledged. 
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Double-click on the new SITE version and type CTRL-F 
to call up the Find/Replace dialog box.  Type 
SpotterAddr | in the Find box and Spotter Address | 
in the Replace box, and click Replace All.  Save your 
changes. 
 
NOTE:  Because we’ve modified the SITE version of 
spotters.dat, any future edits either need to be done 
through the localization perspective to the SITE 
version.  If edits were made to the original version of spotters.dat and 
reimported using the importAdaptivePlot.py script, CAVE would never see 
the new CONFIGURED version because the SITE version always overrides 
the CONFIGURED version. 

6. Restart CAVE, 
and load the 
Spotters 
Readout 
overlay from 
the Maps 
menu. 

Click the Maps menu and load Spotters Readout.  
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 Troubleshooting Tips     

Sometimes importing the .dat files for Adaptive Plan plots works with no problem.  This is the case when the name of 
the file matches the name of the data fields (e.g., the filename is coop.dat and the data fields are coopName, 
coopAddress, etc.)   

If AlertViz gives error messages about the field names, there are two likely reasons: 

• The field names are not complete (e.g., Addr vs. Address), or 
• There’s a mismatch between the name tag in the bundle and the field names. 

Be careful with filenames that might match other map menu entries.  The process of importing spotters.dat resulted 
in a CONFIGURED version of spotters.xml, which overrides the BASE version of spotters.xml, shown here.  This makes 
CAVE never able to access the spotter data contained in spotters.lpi.  One way to fix this would be to use a name 
other than spotters.dat for the original file.  An alternate way would be to copy the BASE spotters.xml bundle to a 
different name as a SITE override. 
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Exercise 4:  Customizing Default Scale Map Backgrounds 
 

Objectives:  In this exercise, you will perform the following procedures: 

• Add Lat/Lon lines over the ocean to the default CONUS scale map as a site override. 
• Customize map overlays on your WFO scale map as a user override.  
• Customize the maps that initially populate your D2D side panels as a user override. 
• Add another WFO’s map scale to your scale pull-down menu. 

 

Background.  In CAVE, the map displays that initially populate the D2D panes are .XML bundle 
files that contain only map background layers.  The default versions of the files are located in 
cave/etc/bundles/scales; these BASE files are accessible through the localization perspective.  
This directory also contains a scalesInfo.xml file that specifies which D2D pane is initially loaded 
with each scale bundle.  (The automated localization tool developed by Raytheon includes site 
override versions of state, regional, and WFO-scale background map bundles which are placed 
in appropriate locations in the Localization Store on the EDEX server.)  Because the panes are 
populated with bundles, the maps in the bundles are easily customized with various display 
options (colors, thickness, line styles, etc.) as well as multiple map overlays per bundle, if so 
desired. 

In this exercise, we’ll start with the default CONUS map and add the Lat/Lon grid over the 
oceans.  We will use the default line styles (gray, thin lines) and use this display bundle as a site-
level override.  Then we’ll move on to adding interstate highways and your CWA border to your 
WFO scale map using various line thicknesses and colors as a user-level override.  Finally, we’ll 
rearrange the scales that are loaded into the D2D panes by default by replacing the Northern 
Hemisphere Scale with the WFO scale and also having the large pane loaded with the regional 
map by default rather than the CONUS map.  We’ll also do this customization at the user level 
so as to not disturb any other user’s default layout.  Both of these customizations involve saving 
the D2D display bundles that contain only customized map overlays, placing the bundles as site 
or user overrides in cave_static, and editing scalesInfo.xml, if necessary.  For the CWA 
boundary, we’ll add a database constraint to limit the boundary to your particular WFO using 
the concepts outlined in Exercise 2.  Finally, to add another WFO’s local WFO-scale map to your 
scale menu, we’ll obtain the map bundle, copy it to the correct location, and edit the site-level 
scalesInfo.xml. 

This exercise should probably take about 15 minutes to complete. 



CAVE/EDEX Step-By-Step Exercises Exercise 4: Customize Default Map Backgrounds  20 

Concept Actions 

Part 1:  CONUS Map Customizations 
1. To add the Lat/Lon 

grid to the CONUS 
map, load a blank 
CONUS map in the 
main D2D pane and 
add the Lat/Lon grid 
map overlay. 

On your CAVE workstation in the D2D 
perspective, clear and/or swap panes to 
get a blank CONUS map.  Then load the 
Lat/Lon 10 over Ocean overlay from the 
Maps menu.   

2. Save the resulting 
bundle display to 
CONUS-latlon.xml 
in your home 
directory.   

From the CAVE menu, click Load/Save Displays followed by Save Editor 
Display.  In the resulting dialog box, name the file 
CONUS-latlon.xml .  By default, the file will likely be saved in your 
home directory. 

 
 
 

 

3. Make a user-level 
override for 
CONUS.xml and 
put the contents 
of CONUS-
latlon.xml in 
CONUS.xml. 

 
Note:  There are two 
methods of performing 
this step.  The first, 
copying/pasting the 
contents of one file into 
another is shown here.  
The second method, the 

In the Localization Perspective, 
navigate to the CONUS.xml 
scale bundle file.  It is located 
under CAVE » Bundles »  
scales » CONUS.xml.  Make a 
user-level override of this file, 
by expanding CONUS.xml, 
right-clicking on BASE, and 
choose Copy To ►User.  
 
Open the user override of CONUS.xml by double-clicking on your 
user’s version. 
 
With CONUS.xml still open, open the CONUS-latlon.xml in a new tab 
by clicking on the File menu followed by the Open File… option, and 
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import file function in 
the Localization 
Perspective, is 
demonstrated below in 
Step 8. 

then by choosing CONUS-
latlon.xml in the resulting dialog 
box.   
 
 

At this point, both CONUS.xml and CONUS-latlon.xml should be open 
in their own individual tabs in the Localization Perspective.  Click on 
the tab for CONUS.xml and delete the contents of that tab (a shortcut 
to do this is CTRL-A followed by the Delete key).   Click on the tab for 
CONUS-latlon.xml and copy/paste its entire contents into the tab for 
CONUS.xml and save it (CTRL-A » CTRL-C » click on the CONUS.xml tab 
»  CTRL-V » CTRL-S.).   

4. Restart CAVE so it 
will reload the 
localization.  The 
site level CONUS 
map should 
include the lat/lon 
grid.  

 

 
5. The CONUS.xml 

with the lat/lon 
grid is only a user-
level override.  
Promote your 
user-level file to 
site (if you’ve been 
granted 

Right-click on your user version 
of CONUS.xml.  Then choose 
Copy To ►Site. 
 
Note:  Now that you have both 
SITE and USER copies of this 
file, be aware any future 
changes to the SITE version will not be seen by your user because your 
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permissions to do 
so.) 

USER file overrides the SITE file.  If you had used Move To ► Site, 
then this potential conflict would be moot. 

Part 2:  WFO scale map customizations 
6. Customize the 

main pane with 
the WFO scale 
map, with yellow 
interstate 
highways and red 
CWA boundaries. 

 
 

7. Save the display 
bundle to  
WFO-custom.xml 
in your home 
directory.  

 
8. Import the new 

WFO-custom.xml 
bundle file into the 
CAVE » Bundles » 
Scales area of the 
Localization 
Perspective and 
rename it to a 
USER version of 
WFO.xml. 

In the Localization Perspective, navigate to   
CAVE » Bundles » Scales) and right-click on 
Scales.  Choose the Import File... option.   
 
 

Navigate to the WFO-
custom.xml bundle file that is 
likely stored in your home 
directory and click the OK 
button.   
 

After the import, you should have a new WFO-custom.xml file located 
under scales.  Open its tab and right-click on the USER version that 
should have been created.  Choose the Move To ► New File... option. 
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In the resulting Rename File 
dialog box, enter WFO.xml.  If 
you already have a USER version 
of WFO.xml, this file will 
overwrite the previous version. 

9. Make a further 
edit in your new 
user version of the 
WFO.xml bundle 
to add the 
constraint 
WFO={your_site} 
and modify the 
overlay label. 

In the WFO.xml (USER) tab, make the edits according to Figure 1: 
• To change the map label, change the <mapName> entry. In this 

example, this entry is OAX CWA.  
• Add the constraint:  <constraint>CWA=’OAX’</constraint>  

 
Save your changes. 
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Figure 1.  Edits to user version of WFO.xml to add CWA constraint. 

10. Use the 
localization 
perspective to edit 
a user version of 
scalesInfo.xml.   

In the Localization Perspective, open 
scalesInfo.xml, and right-click on 
either SITE or BASE and 
Copy To ► User. 

Make the edits according to Figure 2: 
• Remove the <partId> line from the N. Hemisphere mapScale. 
• Change NorthAmerican partId to sideView1 
• Change Regional partId to sideView2 
• Change States partId to sideView3 
• Add a partId tag to WFO by copying the partId tag from States 

and pasting it in the WFO mapScale.  Change the WFO partID 
sideView to 4. 
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Figure 2.  Edits to user version of scaleinfo.xml. 

11. Restart CAVE.  The 
new default D2D 
layout should 
include the new 
WFO map in the 
fourth small pane.  
If you swap the 
WFO map into the 
main pane and 
display the map 
legend, you should 
see the new CWA 
map label.   

Part 3:  Add another WFO’s local WFO scale map 
12. Obtain another 

WFO’s local WFO 
scale map and 
place it in your 
site’s cave_static 
with a name like 
WFO-{xxx}.xml, 
where {xxx} is the 
other WFO’s ID. 

This example uses OAX’s neighbor, DMX.  We obtain the DMX 
WFO.xml file from the cave_static_site.tar.gz file that’s included in the 
AWIPSII_AUTOMATION_TOOL.tgz file that is part of the ADAM 
configuration.    In an EDEX terminal, go to the directory that contains 
AWIPSII_AUTOMATION_TOOL.tgz and extract the 
cave_static_site.tar.gz file.  Then extract the DMX WFO.xml file.   
 
$ tar xvfz AWIPSII_AUTOMATION_TOOL.tgz cave_static_site.tar.gz 
$ tar xvfz cave_static_site.tar.gz ./DMX/bundles/scales/WFO.xml 
 
Move the DMX WFO.xml file to your site’s cave_static: 
 
$ mv ./DMX/bundles/scales/WFO.xml 
/awips2/edex/data/utility/cave_static/site/{your_site}/bundles/
scales/WFO-dmx.xml 
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13. Edit your site’s 
scalesInfo.xml file 
to include the 
additional WFO’s 
scale in your 
WFO’s menu. 

Open your site’s scalesInfo.xml file in the Localization Perspective.  
Make the edits according to Figure 3: 

• Copy and paste the mapScale that references the WFO.xml to 
make a duplicate version.  

• Change the second version so that the displayName says “WFO 
(DMX)” and fileName is WFO-dmx.xml. 

 

 
Figure 3.  Edits to scalesInfo.xml to add another WFO’s scale map to your scale menu.  The new lines to 
add are indicated by the red box. 
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Exercise 5:  Plot Models — Customized Multicolored Fire Weather Station Plot 
 

Objectives:  In this exercise, you will perform the following procedures: 

• Create new plot models based on existing plot models and specify a font other than the 
default font 

• Create a new display bundle based on an existing Station Plot bundle that displays each 
parameter in its own color 

• Add a new menu entry with associated bundle to a user version of the Obs menu 
• Harness the PlotDelegate function in a plot model to customize the cursor readout 

Background.  This exercise illustrates several configurable capabilities of AWIPS-2.  Among 
these is the ability to have user-level customizations of various plots as well as user versions of 
menus.  Once these user-level customizations are performed, they can be promoted to a site-
level where they are available to every user. 

The example here is to create a station model plot for a fire weather map with temperature, 
relative humidity, winds, and apparent temperature (heat index or wind chill).  The process is to 
create a set of plot models (.svg files) along with a corresponding bundle and menu entry.  To 
make the station plot multicolored, we are creating multiple plot models that are referenced in 
a single bundle.  Each plot has its own color (temperature in red, relative humidity in green, 
winds in purple, and heat index/wind chill in white).  If a single color for the plot were desired, 
then a single plot model would include all the displayed parameters. 

The general strategy to perform these types of customizations is to start with something that is 
known to work, make small edits, and test them out individually.  This “build a little, test a 
little” process helps to isolate problems to individual edits or changes.  In this exercise, we’ll 
start with making a new station plot with a single parameter and a corresponding menu entry.  
Then we’ll add new parameters one-by-one.  

Speaking about adding parameters, the plot models can reference meteorological and other 
variables that are in the database, in the processed HDF5 files, or some derived parameters.  
(Not all database parameters are available to the .svg plot models. Only those parameters 
imported by a software construct named pointDataDbDescription are available; check the 
AWIPS-2 Application Development Environment, or ADE, for more details.)  This example uses 
parameters from all three sources.  To know what parameter names can be used in the plot 
model files, you need to view the available parameter names from each of the three sources. In 
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this exercise, the wind and rawMETAR parameters come directly from the HDF files.  To view 
the parameters in a HDF file, use the h5dump command in /awips2/tools.  For example: 

$ cd /awips2/edex/data/hdf5/obs 
$ /awips2/tools/bin/h5dump {metar-yyyy-mm-dd-hh.h5} | grep DATASET 

A similar command would be used to identify parameters contained in other point data files, 
such as a local mesonet.  Use database tools like pgadmin3 to examine the fields in a metadata 
database table.  The process is similar to looking at the city table as shown in Exercise 2, but 
perusing the metadata database rather than the maps database.  Finally, plot models can 
reference some derived parameters; some derived parameters work with point data while 
others are exclusive to gridded or other datasets.  In this exercise, the T parameter is a derived 
parameter.  If it were specified as “temperature”, the data would have been obtained directly 
from the HDF file since that’s the name of the parameter in the HDF file.  The baseline derived 
parameters are included in 
/awips2/cave/plugins/com.raytheon.uf.viz.derivparam_{version}/localization/derivedParameters and 

/awips2/cave/plugins/com.raytheon.uf.viz.derivparam.python_{version}/localization/derivedParameters, while 
local derived parameters would be found in the Localization Store.  The definitions and 
functions for all derived parameters are viewable in the Localization Perspective. 

In this exercise, we’ll start by creating a plot model file for temperature by copying the normal 
Heat Index/Wind Chill plot model because it’s designed to display a single parameter.  Then 
we’ll create a duplicate bundle and menu entry for the station plot.  Then for each additional 
parameter (relative humidity and winds, and apparent temperature), we’ll successively modify 
the station plot bundle and create corresponding plot models. 

This exercise will take about an hour to complete. 
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Concept Actions 

1. Create the first 
Fire Wx Plot 
Model (svg) file for 
T.  The remaining 
svgs for RH, 
Winds, and Heat 
Index/Wind Chill 
are created in 
later steps.  We 
start with the 
baseline HiWc plot 
to make the 
fireWxT.xvg file 
because the HiWc 
plot contains only 
one parameter.   

In the Localization Perspective file browser, open D2D » Plot 
Models » metarHiWcDesign.svg.  Right-click BASE and  
Copy To ► New File… .  This puts a user-editable version of this 
file in the Localization Store. 

              
Rename the file fireWxT.svg, 

 
 

2. Create a Fire Wx 
Plot bundle.  
Start with 
StationPlot.xml 
and make a fire 
weather version 
named 
FireWxPlot.xml.   

In the Localization 
Perspective file 
browser, open 
CAVE » Bundles » 
StationPlot.xml.  
Right-click BASE 
and  
Copy To ► User.  
 
Rename your new 
user version of the 
StationPlot.xml 
bundle file to a new 
bundle to be edited 
in the localization 
perspective. 
Right-click USER and 
Move To ► New 
File… Name the new 
file FireWxPlot.xml. 
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3. Create a menu 
entry for the 
bundle.  We will 
place this entry 
in the Obs menu 
(in its top 
section).  This 
menu is defined 
in 
baseMetar.xml.  
We’ll use the 
localization 
perspective to 
make a user-level 
override of this 
menu.   
  

In the Localization 
Perspective file browser, 
open CAVE » Menus » 
obs » baseMetar.xml.  
Right-click BASE and 
choose Copy To ► User. 
 

Edit the menu file to add the bundle.   In the file browser, 
double-click USER under baseMetar.xml.  We’ll add the Fire 
Weather Plot entry at the top of the menu.  See Figure 1 to see 
what to add in the edit. 
 
The Localization 
Perspective editor may 
appear in either a 
design mode or a source 
mode. To follow these instructions, click the Source tab at the 
bottom of the editor window. 
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Figure 1.  baseMetar.xml with needed changes identified by the red box. 

4. Restart CAVE.  At 
this point, our 
actions have just 
duplicated the 
standard METAR 
plot so that we 
can edit it and 
not disturb the 
original. 
 
 

 
In CAVE, load the new Fire Weather plot to verify that it 
produces a standard METAR plot.  
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5. Edit the 
FireWxPlot.xml 
bundle to 
reference our 
new fireWxT.svg 
plot model file. 

Find the FireWxPlot.xml bundle in the Localization Perspective.  
It is located under CAVE » Bundles » FireWxPlot.xml.  Double-
click USER, and reference Figure 2 to make the edits. 
 
Copy the colorableCapability line from the METAR Station 
Locations section (line 31) and paste it into Box A.  Change the 
colorAsString value to “#FF1111” (dark red). 
 
Change plotSource to “Temperature” in Box B.  This is the 
legend label for this resource. 
 
Change plotModelFile to “fireWxT.svg” in Box C. This connects 
the menu item to our new plot model. 

 
Figure 2.  FireWxPlot.xml edits to change the existing bundle to now reference the new 
fireWxT.svg plot model. 
 

6. Edit the 
fireWxT.svg plot 
model file.  

In the Localization Perspective, find the fireWxT.svg plot.  It is 
located under D2D » Plot Models » fireWxT.svg. Double-click 
USER, and reference Figure 3 to make the edits. 
 
Change plotParam from “StationName” to “T” in line A.  Add 
the plotFormat and the plotUnit as shown.    (Hint:  Copy and 
paste the plotUnit and plotFormat tags from line B and add 
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“Temperature” just in front of “%3.0f”.   The order of the two 
tags is not important.) 
 
Change id from “hiWcText” to “TText” in line B. Change 
plotParam from “HIWC” to “T”. 
 
Change y from “0” to “-10”.  This puts the temperature 10 
pixels up from the center of the plot model (in AWIPS-2 plots, y 
increases towards the south). 
 
At the top of the file, edit the font information in the CSS 
section, according to Figure 4. 
 
In this and in other Localization Perspective edits, be sure to 
save your changes by pressing <CTRL>-S.     

 
Figure 3.  fireWxT.svg edits to change existing Wind Chill parameters to Temperature. 
 

 
Figure 4.  fireWxT.svg edits to modify font settings. 
 

7. Load the Fire 
Weather Plot 
from the CAVE 
Obs Menu to see 
the plot 
constructed thus 
far. 
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8. Copy the 
fireWxT.svg 
model and 
modify it for RH. 

In the Localization 
Perspective, find 
the fireWxT.svg 
plot.  It is located 
under D2D » Plot 
Models » 
fireWxT.svg. Right-
click USER and 
Copy To ► New 
File… 
 
 
 
Name the file fireWxRH.svg. 
 
 
Find fireWxRH.svg under D2D and 
PlotModels, and edit it, referencing Figure 5 
(your line numbers may be slightly different 
than those shown in the accompanying 
figures). 
 
In Line A, change plotParam from “T” to “RH”, the plotUnit to 
“%”, and the plotFormat as shown.  Note the double %% in the 
plotFormat string.  Because % denotes a format specifier, %% 
represents a literal percent sign.  This format causes a line in 
the cursor sampling that reads, for example, “RH: 86 %”. 
 
In Line B, change id to “RHText”, plotUnit to “%” and y to “10”.  
Keep the font as it is already specified. 

 

 
Figure 5.  fireWxRH.svg edits to change Temperature to RH. 

 
 
 

9. Edit the 
FireWxPlot.xml 
bundle to add a 

In the Localization Perspective, go back to edit FireWxPlot.xml.  
Make these changes, referencing Figure 6. 
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resource for RH. Select the entire Temperature Resource and copy/paste it 
below the temperature </resource> tag.  This section will be 
the red box in Figure 6. 
 
Change colorAsString in Box A to “#11FF11” (dark green). 
 
Change plotSource to “Relative Humidity” and plotModelFile to 
“fireWxRH.svg” in Box B and Box C, respectively. 
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Figure 6.  FireWxPlot.xml edits to add RH to the bundle. 
 
 
 
10. Reload the Fire 

Weather Plot in 
CAVE to see the 
RH added to the 
plot.  

 
11. Use the 

StdObsDesign.svg 
plot model file 

In the Localization Perspective, find StdObsDesign.svg and copy 
to user as in Step 1 (D2D » Plot Models, then right-click BASE 
and Copy To ► User). 
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as a starting 
point for edits 
for the wind 
barbs.  This plot 
model illustrates 
the plotDelegate 
function which is 
an embedded 
Python script for 
more 
sophisticated 
formatting in the 
cursor readout.  
Note that the 
plot mode for 
the cursor 
sampled 
parameters is 
“null”.  This 
setting allows 
the plot model 
to pull in the 
parameters so 
they are 
available to the 
plotDelegate 
function.  

 
Rename your new user version of the stdObsDesign.svg.  Right-
click User and Move To ► New File…  
 

 
 
Name the new file fireWxWind.svg. 
 
Edit fireWxWind.svg.   
 
The first edits are for the wind barbs, referencing Figures 7 and 
8.   
 
Delete the lines in Figure 7 highlighted by the red box. 
 
Add the lines highlighted in Figure 8 by the black box. 
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Figure 7.  Initial edits for fireWxWind.svg to remove unneeded parameters. 
 

 
Figure 8.  Additional edits to fireWxWind.svg to add the parameters for cursor sampling. 
 
12. Edit the 

FireWxPlot.xml 
bundle to add a 
resource for 
Wind. 

In the Localization Perspective, go back to edit FireWxPlot.xml.  
Make these changes, referencing Figure 9. 
 
Select the entire RH resource and copy/paste it below the RH 
</resource> tag.  This section will be the red box in Figure 9. 
 
Change colorAsString in Box A to “#FF33FF” (purple). 
 
Change plotSource to “Winds” and plotModelFile to 
“fireWxWind.svg” in Box B and Box C, respectively. 
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Figure 9.  FireWxPlot.xml bundle edits to add the wind resource. 
 
13. Reload the Fire 

Weather Plot in 
CAVE to see the 
wind barbs 
added to the 
plot.  Notice the 
formatted 
cursor sampling.  
The default 
version of the 
plotDelegate 
function in the 
fireWxWind.svg 
file provides the 
METAR readout. 
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14. Edit the 
plotDelegate 
function to add 
more formatted 
wind 
information to 
the cursor 
readout. 

Referencing Figure 10, make the edits indicated in the black 
box. Because this is an embedded Python script, pay special 
attention to the indentation (use spaces and not tabs), which is 
how Python determines if/then/else blocks. 
 
Additional notes about the Python script: 

• The rec.getFloat and rec.getString functions retrieve the 
specified parameters from the database or the HDF files. 

• Unit conversions are not automatically applied in the 
plotDelegate script (as opposed to the parameters in the 
plot models that use the plotMode = sample), so the 
script explicitly converts knots to mph.  Also note that 
the unit conversion for gust appears later in the script 
than the conversion for speed in order to handle the 
missing value for gust. 

• The if statements contain &lt; to represent < because 
the svg interpreter assumes a < sign starts new svg tags 
even if embedded in a script. 

• The original plotDelegate script stripped the first two 
lines from the rawMETAR report (the WMO header and 
site ID).  The output from the final script is the 
formatted wind followed by the METAR report on the 
next line.   
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Figure 10.  Additional edits to fireWxWind.svg to customize the PlotDelegate function for 
advanced formatting of the cursor readout for wind. 
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15. Reload the plot 
to examine the 
cursor sampling 
readout. 

 
16. Copy and use 

the original 
HiWc plot 
model to use it 
for Apparent 
Temperature. 

Rename your new user version of metarHiWcDesign.svg.  Right-
click User and Move To ► New File…  
 

 
 
Name the new file fireWxHiWc.svg.  If we didn’t make a copy, 
the edits we’d make to the file would be reflected in your user’s 
version of the standard Heat Index/Wind Chill plot. 
 
Edit the fireWxHiWc.svg file, referencing Figure 11. 
 
Make the indicated changes to PlotFormat in the sampling line 
and change x to “-15” in the hiWcText line.  Also, make similar 
font changes as in Figure 4. 

 

 
Figure 11.  fireWxHiWc.svg edits. 
 
 
17. Edit the In the Localization Perspective, go back to make final edits to 
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FireWxPlot.xml 
bundle to add a 
resource for 
Apparent 
Temperature. 

FireWxPlot.xml.  Make these changes, referencing Figure 12. 
 
Select the entire Wind Resource and copy/paste it below the 
Wind </resource> tag.  This section corresponds to the red box 
in Figure 12.  
 
Change colorAsString in Box A to “#FFFFFF” (white). 
 
Change plotSource to “Apparent Temperature” and 
plotModelFile to “fireWxHiWc.svg” in Box B and Box C, 
respectively. 

 

 
Figure 12.  Final edits to the FireWxPlot.xml bundle. 
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18. Reload the Fire 
Weather Plot to 
examine the 
finished product. 
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Exercise 6:  Radar Mosaics — Adding Default and Additional Mosaics  
 

Objectives:  In this exercise, you will perform the following procedures: 

• Determine the list of radars closest to an arbitrary lat/lon coordinate. 
• Modify the radar menu for a given WFO’s desired radar mosaics. 

Background.  This exercise illustrates how to customize CAVE to 
display radar mosaics.  By default, CAVE will display a set of 
mosaics based on only one set of radars.  AWIPS-1 had the 
capability to specify any number of mosaics that were based on 
either a list of radars or up to eight radars closest to a lat/lon 
point.  The AWIPS-1 customization was specified using the 
mosaicInfo.txt file in FXA_CUSTOM_FILES.  The menu from 
AWIPS-1 shown here added four additional mosaics (titled West, 
North, South, and East). 

This example customizes CAVE to display the mosaics specified in 
the mosaicInfo.txt for the Indianapolis (IND) WFO, shown in 
Figure 1.  The first mosaic in this mosaicInfo.txt file is the default 
mosaic for IND while the next two mosaics are additional mosaics 
(specified using a lat/lon point).  In AWIPS-2, the customization is 
different for the additional mosaics than for the default mosaic, 
so this exercise has two parts: one for the default and one for 
additional mosaics.   In addition, the CAVE menu system only 
works with lists of radar sites to make the mosaics, so we will first 
have to use the AWIPS-2 metadata database to obtain the list(s) of desired radars.  We’ll use 
pgadmin3 to illustrate our database operations; however, you can optionally use psql, if you 
prefer.  

CAVE is customized for the default mosaic by editing the radarsInUse.txt file in 
common_static/site/{your site}/radar.  When CAVE is restarted, it triggers EDEX to rebuild any 
CONFIGURED menus, if necessary.  As part of this process, EDEX uses radarsInUse.txt to 
construct the CAVE radar menus for the AWIPS site that is specified as AW_SITE_IDENTIFIER in 
/awips2/edex/bin/setup.env. 

We will modify the menus for the additional mosaics by first duplicating the mosaic menu 
entries in baseRadarMenu.xml in a new menu template file.  Second, we’ll modify 
baseRadarMenu.xml to include the new menu template file with a substitute key for 
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mosaicIcaoList for each of the additional mosaics we need to include.  By modifying the menu in 
this manner, the Radar menu should survive re-creation by EDEX when CAVE is restarted.  After 
these modifications, the original mosaics in baseRadarMenu.xml are for the default set of 
radars specified  using radarsInUse.txt.  The additional mosaics are in pull-out menus below the 
default set to mimic the AWIPS-1 behavior. 

Note:  In AWIPS-2, ICAO often refers to a site ID for an observational platform. 

This exercise should take about 20 minutes to complete. 

 

Figure 1.  AWIPS-1 mosaicInfo.txt for the Indianapolis (IND) WFO. 
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Concept Actions 

Part 1: Customizing the Default Mosaic 
1. Edit radarsInUse.txt 

to specify the list of 
radars for the 
default mosaic. 

In a terminal window on the EDEX server as the awips user, go to your 
site’s radar directory in common_static: 
 
$ cd /awips2/edex/data/utility/common_static 
$ cd site/{your_site}/radar 
 
It’s possible that your site’s directory or the radar directories don’t exist.  
If this is the case, go ahead and create them: 
 
$ mkdir site/{your_site} 
$ mkdir site/{your_site}/radar 
$ cd site/{your_site}/radar 
Edit radarsInUse.txt.  If it doesn’t already exist, copy one from the OAX 
localization.  NOTE:  The OAX localization is delivered as an RPM with the 
AWIPS-2 software, and it may be manually installed.  The RPM is typically 
located in the noarch section of the software delivery (e.g., 
noarch/awips2-localization-OAX-13.4.1-1.noarch.rpm). 
 
$ vi radarsInUse.txt 
 
Change the radar sites listed under the MOSAIC_RADARS comment line.  
In our example for the IND default mosaic, we would change the list of 
radars to be kind kiwx klvx kilx kvwx kpah klot kiln kgrr (each on a line 
by itself). 
 
Save your changes and quit: 
 
<esc> :wq 

2. Restart CAVE 
server to trigger 
EDEX to recreate 
the radar menu 
files in 
cave_static/site/ 
{your site}/ 
menus/radar. 

Restart CAVE. 

3. Examine the 
radarindex.xml 
file to verify your 
list of radars. 

In the Localization Perspective file browser, open CAVE » Menus »  
radar » radarindex.xml. Double-click CONFIGURED to view the 
radarindex.xml file.  If no CONFIGURED file appears, then the site ID in 
CAVE Preferences may be set incorrectly. 
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You should see your list of radars specified as mosaicIcaoList (our 
example is shown in Figure 2). 

 

 
Figure 2.  radarindex.xml for default mosaic. 

Part 2: Specifying Additional Mosaics 
4. Start pgadmin3 

and perform the 
SQL queries to 
obtain the list of 
radars closest to 
specific lat/lon 
coordinates. 
The lat/lon 
point we are 
using here is  
(109W, 40N). 

Start pgadmin3.  Open the metadata database and the awips schema.  
Click the SQL query button.   

 
Enter the SQL query as shown in Figure 3. 
 
select * from radar_spatial where rda_id like ‘K%%%’ order 
by ST_distance(the_geom, ST_GeomFromText(‘POINT(-109 
40)’,4326)) LIMIT 8; 
 
 
In this query, we included the “where radar_id like ‘K%%%” clause 
because the radar_spatial table includes geographical information for a 
number of FAA radars that the NWS currently doesn’t access.  Thus, this 
clause restricts the results to WSR-88D units within the CONUS.  Sites 
outside the CONUS probably already know their relatively small list of 
radars and could probably skip the step of running these queries.  Also in 
the above query, the 4326 refers to the Spatial Reference system ID 
(SRID) the database uses.   
To run the query, press the run (execute query) button.  

 
 
The results are shown in Figure 4. 
For our example, we’ll run another version of the query for the south 
mosaic: 
 
select * from radar_spatial where rda_id like ‘K%%%’ order 
by ST_distance(the_geom, ST_GeomFromText(‘POINT(-95 
35)’,4326)) LIMIT 9; 
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We used LIMIT 9 because one of the returned radars was KCRI, the test 
radar operated by the Radar Operations Center. We’ll omit this radar in 
our list so we needed an extra radar to take its place.   
(By the way, AWIPS-1 arbitrarily limited the number of radars in a mosaic 
for a WFO to nine. There is no such limit in AWIPS-2.  It’s unknown if a 
large number of radars to construct a mosaic will result in performance 
issues). The results of this query are shown in Figure 5. 

 
Figure 3.  SQL query in pgadmin3 to determine 8 closest radars to a lat/lon point. 

 
Figure 4.  Results of SQL query for 8 closest radars to lat/lon point for the west mosaic. 

 
Figure 5.  Results of SQL query for 9 closest radars to lat/lon point for the south mosaic. 
5. We need to make a 

SITE version of  
baseRadarMenu.x
ml in the 
Localization 
Perspective.  

On a workstation with CAVE, 
open the Localization 
Perspective file browser and 
navigate to CAVE » Menus» 
radar » baseRadarMenu.xml.  
Make a SITE version by right-
clicking BASE and choosing 
Copy To ►Site. 
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6. Copy the 
baseRadarMenu.x
ml file to 
mosaicMenu.xml. 

Copy the SITE version of the 
baseRadarMenu.xml file 
that you just obtained to 
mosaicMenu.xml.  Right-
click SITE under 
baseRadarMenu.xml and 
choose Copy To ►New File. 
 
 
Call the new file mosaicMenu.xml.

 
 

7. Edit 
mosaicMenu.xml so 
it contains only 
mosaic menu 
entries. 

Find the new mosaicMenu.xml in the localization perspective.  Edit the 
new site version by double-clicking SITE. 
 
At the top of the file, delete the lines indicated by the red box in Figure 
6. 
 
Move to the bottom of the file and delete the lines indicated by the 
red box in Figure 7. 
 
Save the changes to the file and quit. 
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Figure 6.  First edits to mosaicMenu.xml to delete lines (indicated by the red box) before 
the mosaic entries. 
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Figure 7.  Edits to the bottom of mosaicMenu.xml to delete lines (indicated by the red box) after the 
mosaic entries. 

8. Edit 
baseRadarMenu.xml 
to include 
mosaicMenu.xml for 
each new mosaic 
we wish to add.  
Preserve the 
existing mosaic 
entries in 
baseRadarMenu.x
ml because those 
entries control the 
default mosaics. 

Open the site version of baseRadarMenu.xml by double-clicking SITE. 
 
Near the bottom of the file, add the lines in Figure 8 indicated by the 
red box.  These lines add references to mosaicMenu.xml for both the 
West Mosaic and the South Mosaic.  
 
When you’re done editing, save your changes. 
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Figure 8.  Final edits near the bottom of baseRadarMenu.xml for the additional mosaics. 
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9. Restart CAVE and 
verify the Radar 
menu reflects the 
changes and that 
the mosaics display 
in CAVE. 

 
10. Verify regular 

expression patterns 
in the  distribution 
radar.xml and/or 
the LDM 
pqact.conf. 

If your mosaics do not display, particularly due to the lack of data, you 
may need to verify that the radars specified in our versions of 
mosaicIcaoList in the baseRadarMenu.xml and the radars listed in 
radarsInUse.txt are actually being ingested.  Verify that the patterns in 
the EDEX distribution radar.xml file (base and site versions) and the 
LDM pqact.conf match the WMO headers for the SBN radars. 
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Exercise 7:  Radar Mosaics — Adding New Products for Mosaicking 
 

Objective:  In this exercise, you will perform the following procedures: 

• Modify the radar menu to add a mosaic for a new radar product. 

Background.  This exercise illustrates how to customize CAVE to add a new radar mosaic to the 
Radar menu.  As shown in Exercise 6, the baseRadarMenu.xml file is found in the Localization 
perspective under CAVE » Menus » radar (the actual file is located in the CAVE radar plugin, in 
its localization/menus/radar directory).  Examination of this file shows that mosaics are 
produced using the DefaultRadarMosaic.xml bundle. 

For this exercise, we’ll add a mosaic of a Dual-Polarization base product called Correlation 
Coefficient (CC) at 0.5° elevation.  The process is to make a site or user override of 
baseRadarMenu.xml and add another entry for our mosaic. 

This exercise should take about 10 minutes or less to complete. 

Concept Actions 

1. If you don’t 
already have a 
SITE version of 
baseRadarMenu.x
ml, make one in 
the Localization 
Perspective.   If 
you’ve completed 
Exercise 6, you 
will have already 
done this step. 
 

On a workstation with CAVE, 
open the Localization 
Perspective file browser and 
navigate to CAVE » Menus » 
radar » baseRadarMenu.xml.  
Make a SITE version by right-
clicking BASE and choosing 
Copy To ►Site. 
 
 

2. Edit 
baseRadarMenu.x
ml to add a 
mosaic for 0.5° 
CC.  We’ll use the 
8-bit version of 
CC, which is 
product number 
161. 

Open the site version of baseRadarMenu.xml by double-clicking SITE. 
 
Near the bottom of the file, add the lines in Figure 1 indicated by the red 
box.   
 
When you’re done editing, save your changes. 
 
NOTE:  If you’ve added custom mosaics (for example, like the one in 
Exercise 6), you may need to make similar edits to other menu files (e.g., 
mosaicMenu.xml which was created in Exercise 6). 
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Figure 1.  Edits to baseRadarMenu.xml to add a menu entry for 0.5 Correlation Coefficient. 
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3. Verify that the 
Radar menu was 
updated with 
the new mosaic. 

Restart CAVE, click the Radar menu, and load the Dual Pol Correlation 
Coefficient mosaic 
product. 
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Exercise 8:  Customizing Individual Radar Menus 
 

Objective:  In this exercise, you will perform the following procedures: 

• Rearrange the individual radar menus to place most used products near the top of the 
menus. 

Background.  AWIPS-1 provided the ability to customize the local radar menus by modifying the 
radarDataMenus.template file in your localization/LLL directory.  Several WFOs have taken 
advantage of this capability by putting more frequently used products near the top of the menu 
and lesser used products closer to the bottom.  This exercise demonstrates how to perform 
similar configurations in AWIPS-2.   

In addition, the baseline radar menus were reorganized with the deployment of dual-
polarization radars.  Hence, the CAVE radar plugin actually contains two sets of menus.  The 
legacy version of the radar menus is located in 
/awips2/cave/plugins/com.raytheon.viz.radar_{version}/localization/menus/radar and the 
dual-pol version is in 
/awips2/cave/plugins/com.raytheon.viz.radar_{version}/localization/menus/radar/dualPol. 
Accordingly, the localization perspective contains both sets of files (CAVE » Menus » radar and 
CAVE » Menus » radar » dualPol).    

Before starting on this customization, it is helpful to review how the local radar and dial radar 
menus are created.  When CAVE starts up, it triggers EDEX to read 
common_static/site/{siteID}/radar/radarsInUse.txt, for whichever site is specified in CAVE’s 
localization preference.  If EDEX detects a change in radarsInUse.txt, then it builds index.xml in 
cave_static/configured/{siteID}/menus/radar.  For each WSR-88D, this index.xml includes 
menus/radar/dualPol/baseLocalRadarMenu.xml, and for each TDWR, it includes 
menus/radar/dualPol/baseTerminalLocalRadarMenu.xml.  The default versions of these files 
are located in the plugin’s menus/radar/dualPol directories as specified above.  Like other D2D 
perspective menus, local customizations of baseLocalRadarMenu.xml and 
baseTerminalLocalRadarMenu.xml can be either site or user overrides in 
cave_static/…/menus/radar/dualPol.  Additional custom menus can be created, so long as they 
are referenced in baseLocalRadarMenu.xml or baseTerminalLocalRadarMenu.xml.  As with 
most other CAVE configuration files, these menus can be viewed and edited using the 
Localization Perspective.  Be aware that similarly named files exist both in menus/radar and in 
menus/radar/dualPol.  Be sure to edit the correct file! 
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NOTE:  To perform this exercise, your user must have SITE editing privileges (primarily for 
com.raytheon.localization.site/cave_static/ or 
com.raytheon.localization.site/cave_static/menus).  For more information on this, see the 
Foundational lesson on the Localization Perspective. 

Because of the complexity of the radar menus, it will be helpful to reference Figure 1, which 
illustrates which menu .xml files contribute to the particular sections of the default radar 
menus as specified in baseLocalRadarMenu.xml.  We will use some of these menu .xml files as-
is.  We will copy and paste from some of the menus as well.   We will use the Localization 
Perspective to perform all of the menu editing. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1.  Default local radar menu in AWIPS-2 along with the  
menu xml files that contribute to the menu layout.  All the files  
listed here are referenced by baseLocalRadarMenu.xml 

Our goal is to create the menu layouts as shown in Figure 2.  Owing to this menu complexity, 
we will use a “build-a-little, test-a-little” process.  We will start by creating a custom version of 
baseLocalRadarMenu.xml, and making brand new menu files for the baseData and the 
baseDataTilts sections.   

This exercise will probably take about 1.5 hours to complete.    

Figure 2.  Custom menu layout 
created in this exercise. 
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Concept Actions 

1. If you don’t already have a 
site version of 
baseLocalRadarMenu.xml, 
make a site override of the 
dualPol version using the 
Localization Perspective. 

In the file browser, open CAVE » Menus » radar » dualPol » 
baseLocalRadarMenu.xml.  Right-click BASE and select  
Copy To ►Site. 

 
 

2. Edit 
baseLocalRadarMenu.xml to 
add a contribution from a 
new baseData.xml menu we’ll 
create in the next step.   
Comment out all other menu 
contributions. 

Edit the baseLocalRadarMenu.xml file by double-clicking on 
SITE.  Make it look like Figure 3.  The first contribute line is 
changed to reference baseData.xml.  The second line was 
changed so it starts with a <!-- to specify a comment, and the 
comment ends with  --> just after the contribution for Radar 
Applications. 
 

 
When you’re done editing, save your changes. 
 

 
Figure 3.  Edits to baseLocalRadarMenu.xml to include the menu contribution for baseData.xml and 
comment out the rest of the menu contributions. 
 

3. This new baseData.xml will In the file browser, open CAVE » Menus » radar » dualPol » 
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be the top section of the new 
menu, labeled “Base Data”, 
with six 0.5 entries (0.5 Refl 
through 0.5 DP 8-Prod 4 
Panel) and three All-Tilts 
entries (Z/V, S/SRM, and DP 
8-Prod 4 Panel).   
 
Create baseData.xml from 
baseRadarBestResZV.xml.  
We’re using 
baseRadarBestResZV.xml 
because it already contains 
the 0.5 and All Tilts entries 
for Z/V.  We’ll manually add 
other 0.5 menu entries and 
the All Tilts entries for Z/SRM 
and the DP 8-Prod 4 Panel in 
a later step. 

 

baseRadarBestResZV.xml.  
Right-click BASE and select  
Copy To ►New File. 
 
Name the file 
baseData.xml. 
 
baseData.xml should be a 
User version by default.  
Move it to Site by right-
clicking on USER and 
choose Move To ►Site. 
 

 

4. Edit baseData.xml to change 
the first title item. 

Make the following edit to baseData.xml (in the dualPol 
section) using the Localization Perspective. 
 
Change the titleText and id for the titleItem as shown in the 
black box in Figure 4. 
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Figure 4.  First edits to baseData.xml as described in Step 4. 

5. Copy and paste the 0.5 Refl 
entry from 
baseRadarBestResBase.xml 
into baseData.xml 

In the Localization Perspective, open the BASE version of 
baseRadarBestResBase.xml.  It should open into a new tab. 
 
Copy the lines that reference the “0.5 Z best res” (the bundle 
item and not the subMenu above it) from near the top of the 
file as shown by the red box in Figure 5.  Paste these into the 
baseData.xml tab just below the BaseData titleItem we 
created in Step 4. Change the menuText in baseData.xml from 
“0.5 Z best res” to “0.5 Refl” Close the 
baseRadarBestResBase.xml file.  The resulting baseData.xml is 
shown in the top section of Figure 6. 
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Figure 5.  Lines in baseRadarBestResBase.xml to paste into baseData.xml. 

6. In baseData.xml, duplicate 
the lines just pasted and 
modify them for the 0.5 
Velocity. 

Select and copy  the lines for the 0.5 Refl bundle and paste 
them just below the bundle. 
 
Modify the second bundle contribution as shown in Figure 6.   
Change the menuText to 0.5 Vel and the id to ${icao}05Vel 
(Box A). Change product1 to 154, product2 to 99, product3 to 
27, and product4 to 25 (Box B).  These values were based on 
the 0.5 Vel entry that was specified in 
baseRadarBestResBase.xml. 
 
NOTE:  The product numbers referenced in these bundle files 
are also field values in the radar table of the metadata 
database, and form part of the dataURI for radar data.  These 
numbers are identical to the WSR-88D product numbers 
defined in Table III of the WSR-88D Interface Control 
Document for the RPG to Class 1 User, available from the 
Radar Operations Center (http://www.roc.noaa.gov). 
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Figure 6.  Edits to baseData.xml for the 0.5 Vel menu entry. 

7. Duplicate the lines in the  
0.5 Vel section for the  
0.5 SRM menu entry. 

Look at the BASE version of the dualPol 
baseRadarBestResBase.xml file to see the entry for the 0.5 
SRM entry (it’s located near line 370).  Notice that it’s very 
similar to the lines we just modified for the 0.5 Vel entry, so 
we’ll use them again.  In baseData.xml, duplicate them in a 
similar manner as in the previous step.  Close 
baseRadarBestResBase.xml. 
 
As shown in Figure 7, change the menuText to “0.5 SRM” and 
the id to “${icao}05SRM” (Box A).  
Change both product3 and product4 to “” and set the mode 
to “SRM8” (Box B). Leave product1 and product2 as-is. 
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Figure 7.  Edits to baseData.xml for the 0.5 SRM menu entry. 

8. The menu item 0.5 Z/V Best 
Res product is already in 
baseData.xml.  We need to 
modify its menuText label 
and then copy the entry for 
Z/V to make a Z/SRM8.  The 
baseRadarBestResZSRM.xml 
file shows what the Z/SRM8 
menu entry should look like.  

Find the 0.5 Z+V entry in baseData.xml file.  It should be the 
next entry, just after the 0.5 SRM entry we just created.   
Change the menuText from “0.5 Z+V” to “0.5 Z/V” as shown in 
the red box in Figure 8.  Copy/paste the entire entry for 0.5 
Z/V (shown in the black box in Figure 8) to duplicate it so the 
second can be used for 0.5 Z/SRM. 
 
In the new entry (Figure 9), change the menuText to “0.5 
Z/SRM8” (Box A) and the id to “%{icao}058bitZSRM” (Box B).  
Change the values for product7 and product 8 to “” and 
mode2 to “SRM8” (Box C). 
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Figure 8.  0.5 Z/V section of baseData.xml to be copied to make a new 0.5 Z/SRM section. 
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Figure 9.  Edits for the new 0.5 Z/SRM section of baseData.xml. 

9.  The next menu entry 
contribution to add is for the 
0.5 dual pol 8-product 4 
panel after the 0.5 Z/SRM.  
We also need to add a 
titleItem to separate the 0.5 
and the All Tilts entries in the 
Base Data section.   

The menu item we need to add is defined in the baseline file 
baseRadarFourPanel.xml. Comparing that entry with the 0.5 
Z/SRM8 entry, we can see that we can duplicate the 0.5 Z/SRM8 
entry but change the bundle file, the id, and the menu text plus 
remove the unneeded substitute keys, as shown in the black box 
in Figure 10. 

• Change the menuText to “0.5 DP 8-Prod 4-Panel”  
• Change the bundle file to 

“bundles/DefaultRadarDualPolBaseData.xml”  
• Change the id to “${icao}05dualPolBaseData”  

Add the titleItem as shown by the red box in Figure 10. 
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Figure 10.  Edits to baseData.xml to add the 0.5 8-Product 4 Panel. 

10. Delete the next entries in 
baseData.xml which we no 
longer need.   
Create a Z/SRM8 All Tilts 
entry.   
Delete the remaining 
unneeded entries. 
Create an All-Tilts version of 
the 8-Product Dual-Pol 4-

Move down just below the 0.5 DP 8-Prod 4 panel entry and 
the titleItem we just added, and delete the next two entries 
for 0.9 Z+V and 1.5 Z+V.  The All Tilts Z+V should appear next, 
and we’ll keep this entry, but change the menuText from “All 
Tilts Z+V” to “All Tilts Z/V” (black box in Figure 11) 
 
Copy/paste the All Tilts Z/V entry to duplicate it for the All 
Tilts Z/SRM entry.  Make the changes indicated in red boxes in 
Figure 11:   
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Panel. • Change the menuText to “0.5 Z/SRM8”, 
• Change the id to “%{icao}058bitZSRM” 
• Change the values for product7 and product 8 to “” 
• Change the value for mode2 to “SRM8”. 

Delete the entries (for 0.5 Z+V, 0.9 Z+V, and 1.5 Z+V) until  
you get to the All Tilts Z+V entry.  Keep the All Tilts Z+V, but 
change its menuText to “All Tilts Z/V”, and then delete the 
rest of the entries (the Hi Tilts V sub menu).  Delete the 
separator following the Z/V entries.  Just prior to the last line 
in the file (</menuTemplate>) copy/paste the 0.5 DP 8-Prod 
4-Panel (the red box in Figure 12) so it appears as the black 
box in Figure 12, which illustrates the bottom portion of the 
file.   In the black box version, 

• Change the menuText to “All Tilts DP 8-Prod 4 Panel” 
• Cange the id to ${icao}AllTiltsDualPolBaseData 
• Change the elevation value to “0.0--360.0” 

   
The whole baseData.xml file should probably be around 140 
lines long or so, depending whether or not you added any 
blank lines for readability.  If you haven’t done so already, 
save the baseData.xml file 
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Figure 11.  Edits to baseData.xml to change the menuText label for All Tilts Z/V and to add the All Tilts 
Z/SRM . 
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Figure 12.  Bottom portion of baseData.xml once all edits have been performed. 
11. Restart CAVE and verify that 

the local radar menu shows 
only the 9 entries we’ve 
created plus the two title 
items. 

 
12. Now we’ll work on the Base 

Data Tilts section.  We’ll use 
the  
baseRadarBestResBase.xml 

In the file browser, open CAVE » Menus » radar » dualPol » 
baseRadarBestResBase.xml.  Right-click BASE and select  
Copy To ►New File. 
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file in the dualPol section to 
create our 
baseDataTilts.xml.  We use 
baseDataBestResBase.xml 
as a starting point because it 
already contains pull-out 
menus for most of the radar 
parameters we want:  Z, V, 
SRM, SW, ZDR, CC, and KDP 
(see Figure 1). 

Name the file 
baseDataTilts.xml. 
 
 
 
 
 
 
 
 
 
 
Move the new user 
version of 
baseDataTilts.xml to 
a Site version.  Right 
click on USER and 
choose Move To ► 
Site. 
 
 
 
 

13. Open the new 
baseDataTilts.xml by 
double-clicking on its SITE 
icon.  Modify the first 
titleItem in 
baseDataTilts.xml.   

As shown in Figure 13, change the titleText in the first 
titleItem to “------ Base Data Tilts -----“ and the id to 
“${icao}BaseDataTilts”.  Save your changes. 

 
Figure 13.  First edits to baseDataTilts.xml to modify the titleItem.   
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14. Include the 
baseDataTilts.xml and a new 
separator in the main 
baseLocalRadarMenu.xml 
menu. 

In the SITE version of baseLocalRadarMenu.xml, add the two 
lines indicated in Figure 14.  Save your changes. 

 
Figure 14.  Edits to baseLocalRadarMenu.xml to include a new separator and the new baseDataTilts.xml 
contribution.   

15. Back in baseDataTilts.xml, 
make a few cosmetic 
changes to the menu text 
for the Z and V sub menus. 

As shown in Figure 15, change the menuText for the Z sub 
menu from “${icao} Z” to “Refl”, at approximately line 24. 
 
Similarly, at approximately line 196, change the menuText for 
the V subMenu from “${icao} V” to “Vel” (Figure 16). 

 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 15.  Edit to baseDataTilts.xml to change the menuText of the Z subMenu. 
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Figure 16.  Edit to baseDataTilts.xml to change the menuText of the V subMenu. 

16. Make additional cosmetic 
changes to the menuText of 
the remaining subMenus 

At the following places in baseDataTilts.xml, change the 
menuText accordingly: 

• Line 368:  “${icao} SRM” to “SRM”   
• Line 541:   “${icao} SW” to “Spectrum Width” 
• Line 714:   “${icao} ZDR” to “ZDR” 
• Line 887:   “${icao} CC” to “CC”  
• Line 1060: “${icao} KDP” to “KDP” 
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17. Test our changes.  Restart 
CAVE and look at a local 
radar menu. 

 
 

18. The next pullout menu to 
add is for Z/V.  Looking at 
Figure 1, we can see that 
the baseline Z/V pull out 
is in 
baseRadarBestResZV.xml.  
We’ll make a SITE copy of 
that file, and make a few 
modifications. 

Right-click on BASE under 
baseRadarBestResZV.xml 
and choose Copy To ► 
Site.  
 
  
 
 

19. Edit the SITE version of 
baseRadarBestResZV.xml 
to remove the titleItem, 
and slightly rearrange the 
Z/V menu.  The Z/V menu 
has the 0.5, 0.9, and 1.5 
entries, then the All Tilts, 
followed by a submenu 
with the remaining tilts.  
We will remove the 
submenu but save its 
contents.  We also move 
the All Tilts to the bottom 
of the file so that the tilt 

Delete the titleItem contribution near the top of the file (lines 
shown in Figure 17).  
 
Move (cut/paste or copy/paste/delete) the All Tilts contribution 
(black box in Figure 18) to near the bottom of the file (just after 
the 19.5 entry shown in Figure 19).   
 
Delete the contribution for the Hi Tilts Z+V submenu (red box in 
Figure 18). 
 
Delete the </contribute> tag in Figure 19 (red box) that was the 
closing tag for the Hi Tilts Z+V submenu contribution.  Verify the 
bottom of the file matches Figure 20. 
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sequence is correct (e.g., 
1.5, 1.8, 2.4, ..., 19.5, All 
Tilts). 

Note:  Consider 
improving the 
indentation (alignment) 
of the menu entries 
that were inside the 
submenu, for improved 
readability.  The 
Localization Perspective 
text editor has some 
tools to help with 
indentation, including 
the Shift Right and Shift Left options under the Source menu. 
 

 
Figure 17.  Title item to be deleted from the SITE version of baseRadarBestResZV.xml. 
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Figure 18.  All Tilts contribution in the SITE version of baseRadarBestResZV.xml to be moved to the end 
of the file and submenu contribution to be deleted. 
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Figure 19.  Tag to be deleted in the SITE version of bestRadarBestResZV.xml. 

 
Figure 20.  Bottom portion of the SITE version of bestRadarBestResZV.xml once all edits have been 
completed. 
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20. Make a Site version of 
baseRadarBestResZSRM. 

Right-click on BASE under baseRadarBestResZSRM.xml and 
choose Copy To ► Site. 
 
Edit the Site version of 
baseRadarBestResZSRM.xml. 
 
 
 
 

21. Perform similar edits in 
baseRadarBestResZSRM.xml 
as we just did in 
baseRadarBestResZV.xml. 

Edit the SITE version of baseRadarBestResZSRM.xml and 
perform the following edits: 
 

• Delete the “Best Res Z+SRM8 combo” titleItem near 
the top of the the file (Figure 21). 

• Move the All Tilts entry (black box in Figure 22) to the 
bottom of the file (just before the very last 
</contribute> tag). 

• Delete the “Hi Z+SRM8 tilts” subMenu contribute 
entry just below where the All Tilts entry was (red box 
in Figure 22). 

• Delete the very last </contribute> tag in the file (this 
would be the closing tag for the subMenu contribute 
we just deleted). 

• Save the file. 
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Figure 21.  TitleItem to be deleted from baseRadarBestResZSRM.xml. 

 
Figure 22.  Edits in baseRadarBestResZSRM.xml to move the All Tilts to near the bottom of the 
file and to delete the “Hi Z+SRM8 tilts” submenu. 

22. Attach the Z/V and Z/SRM 
files as pullout submenus to 

In baseDataTilts.xml, add the two contribute lines indicated in 
Figure 23.  They go between the SRM and the Spectrum 
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the baseDataTilts.xml file.  Width portions of the file. 
Save the baseDataTilts.xml file. 

 
Figure 23.  Edits to baseDataTilts.xml to attach the baseRadarBestResZV.xml  
baseRadarBestResZSRM.xml files as submenus.   
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23. Test the progress so far by 
restarting CAVE and looking 
at a local radar menu. 

 
 
 
 
 

24. We still need to add pullout 
menus for the 8-Prod DP 4 
Panel and the HC Analysis 4 
Panel.  To do this, we’ll 
make SITE versions of 
baseRadarFourPanel.xml 
(which contains the baseline 
menus for the two Four 
Panels; see Figure 1) and 
rearrange them slightly, 
similar to the Z/SRM and 
Z/V submenus. 

Right-click on BASE 
under 
baseRadarFourPanel.x
ml in the dualPol 
section and select Copy 
To ► Site. Double-click 
on the SITE icon to 
open the file.   

25. This file contains two 
sections, one for the 8-
Product 4 Panel and the 

In the Site version of baseRadarFourPanel.xml, make the 
following changes:   

• change the titleItem contribute (black box in Figure 
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other for the HC analysis 4 
Panel.  We’ll do similar edits 
for both, starting with the 8-
Product 4 Panel, near the 
top.  We’ll change the 
titleItem contribute to a 
submenu contribute, move 
the All Tilts entry to the end 
of the 8-Prod section, delete 
the opening subMenu 
contribute for the Hi tilts, 
but leave the closing 
contribute (previously used 
for the Hi Tilts submenu) 
and re-use it to put the 
entire 8-Prod section in a 
self-contained submenu. 

24) to submenu by changing the xsi:type from 
“titleItem” to “subMenu”, changing the entire 
titleText=”------ 4 Panel 
Z+SRM/ZDR+V/KDP+HC/CC+SW ------“ tag to 
menuText = “8-Prod DP 4 Panel”, and deleting the 
closing forward slash (/) before the closing angle 
bracket so it reads: 
<contribute xsi:type=”subMenu” 
id=”${icao}4PanelZ+SRMZDR+VKDP+HCCC+SW” 
menuText=”8-Prod DP 4 Panel” >.  The closing tag will 
be the </contribute> from the pre-existing Hi Tilts 
submenu. 

• Move the All Tilts entry (red box in Figure 24) to just 
after the closing </contribute> tag for the 19.5 base 
data entry (approximately line 120 as shown by the 
black box in Figure 25) 

• Delete the Hi base data tilts submenu contribute (blue 
box in Figure 24). 

 

 
Figure 24.  Edits to the 8-Product 4-Panel section of the SITE version of 
baseRadarFourPanel.xml. 



CAVE/EDEX Step-By-Step Exercises Exercise 8: Custom Radar Menus  84 

 
Figure 25.  Edits to the bottom of the 8-Product 4-Panel section and the top of the HC analysis 
section in the SITE version of baseRadarFourPanel.xml. 

26. Edit the HC analysis section 
of baseRadarFourPanel.xml, 
with similar changes as just 
made to the 8-Product 
section. 

Delete the separator between the 8-Product and HC analysis 
sections (red box in Figure 25). 
 
Change the titleItem contribution (blue box in Figure 25) to a 
subMenu.  Make it read: 
<contribute xsi:type=”subMenu” 
id=”${icao}4PanelZZDRHC+KDPCC” menuText=”HC Analysis 4 
Panel”>   
(Note:  the closing tag is > and not />). 
 
Move the All Tilts HC analysis entry (black box in Figure 26) to 
just before the closing </contribute> tag in the file (just after 
the 19.5 entry). 
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Delete the submenu contribute for the HI HC analysis tilts (red 
box in Figure 26). 
 
Save the file. 

 
Figure 26. Edits to HC analysis section of baseRadarFourPanel.xml. 

27. To add the 
Derived/Graphics section, 
we’ll use a copy of 
baseRadarDerivedProducts.
xml and call it 
mainDerivedGraphics.xml.  
The edits from here on out 
are much simpler, mostly 
deleting entries we don’t 
need and placing submenus 
in the correct location. 

Right-click on 
BASE under 
baseRadarDerived
Products.xml in 
the dualPol 
section and select 
Copy To ► New 
File.   Name the 
new file 
mainDerivedGrap
hics.xml.  This file 
should default to a USER version.  Make it a site version by 
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right-clicking on 
its USER icon and 
selecting Move To 
► Site. 
 
 
 
 
 
 
 

28. Delete the HC section.  
None of these deleted items 
will be unavailable because 
we will include the entire 
baseRadarDerivedProducts.
xml as a pull out menu in a 
later step.  

Delete the entire HC section which spans near the top of the 
file (Figure 27) to just before the Composite Reflectivity 
section (Figure 28) near line 196.   
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Figure 27.  Top of HC selection to be deleted in mainDerivedGraphics.xml. 

 
Figure 28.  Bottom of HC selection to be deleted in mainDerivedGraphics.xml. 
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29. Delete three bundle items 
that are now near the top of 
the file.  These are the 1km 
Composite Reflectivity, the 
4 Composite Reflectivity, 
and the VIL/Composite 
Reflectivity combination 
product. 

Delete the lines indicated in the black box in Figure 29. 

 
Figure 29.  Three contributions to be deleted from mainDerivedGraphics.xml 

30. Keep the next four 
contributions for the 
bundles for (VIL, DVL, ET, 
and EET).   

Delete the remaining contributions starting with the 
separator just below the EET bundleItem entry (Figure 30).  
Don’t delete the final </menuTemplate> tag in the file.  The 
final mainDerivedGraphics.xml file is shown in Figure 31. 
Save your changes to mainDerivedGraphics.xml. 
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Figure 30.  Top portion of remaining entries to be deleted from mainDerivedGraphics.xml. 

 
Figure 31.  Final version of mainDerivedGraphics.xml 

31. Edit 
baseLocalRadarMenu.xml to 
add our new FourPanel and 
DerivedGraphics menus and 

In the baseLocalRadarMenu.xml, make these changes: 
• Delete the items indicated in Figure 32.  Content from 

these items are included in the menus we’ve just 
worked on. 
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to rearrange existing 
submenus. 

• Add the lines indicated in Figure 33.  This adds the two 
Dual-Pol four panel entries, a separator and titleItem 
for the Derived/Graphics section, and the five non-
pull-out menus in the DerivedGraphics section from 
mainDerivedGraphics.xml. 

• Uncomment the final section of the menu 
contributions, and add the separator and titleItem 
shown in Figure 34.  Figure 34 shows the final version 
of baseLocalRadarMenu.xml 

 
Figure 32.  Items in baseLocalRadarMenu.xml to be deleted. 

 
Figure 33.  Items in baseLocalRadarMenu.xml to be added. 
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Figure 34.  Final edits to baseLocalRadarMenu.xml. 
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32. Restart CAVE to see the final 
result.  
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Exercise 9:  Implementing Custom Model Families from the AWIPS-1 Virtual Field Table 
 

Objectives: 

• Reorganize the Volume menu to implement custom Model Families.  The existing 
default/baseline model families are preserved, but are located in various pull-out 
menus. 

• Edit display bundles for each of the model families to be implemented, defined either in 
a single-pane layout or a four-panel layout. 

• Use the firstAvailableResourceData bundle construct to allow the software to make a 
choice between alternative model fields. 

• Use the blendedResourceData to make a paired image combination. 

 

Additional Concepts Mentioned in This Exercise: 

• Bundles with four-panel displays  
• Panel combo rotate 
• Wind barb, vector arrow, and streamline plots 
• Icon plots 
• Layers, levels and the Level Mapping File:  fixed height above ground (FHAG or 

LYRFHAG), constant pressure (MB), potential vorticity (PV), potential temperature (K), 
equivalent potential temperature (Ke), boundary layer (BL), entire atmosphere (EA), 
surface (SFC), freezing level (FRZ), lifted condensation level (LCL), cloud base level (CBL) 

• Colors available in CAVE 

 
Background.  In AWIPS-1, model families were 
implemented using the Virtual Field Table, 
specified in a custom virtualFieldTable.txt.  
Accordingly, sites could modify the volume 
menu and organize model output in new ways.  
AWIPS-2 provides similar customizable 
capabilities, but the process is totally different.  
Not only can you create model families for a 
WFO, you can also make new displays for 
particular users.  This user-level configuration 
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capability may be handy in developing new displays, as well as evaluating new techniques prior 
to implementing them in a wider setting.   In this exercise, we’ll use a sample Virtual Field Table 
as a starting point to implement model families first as a user-level customization and then 
illustrate how to promote the changes to a site-level configuration.   

A significant number of forecast offices have utilized Dan Baumgardt’s derived parameters and 
associated model families.   This package, containing both the derived parameters and the 
model family configuration files, was included in the AWIPS-2 baseline.    Some WFOs utilize 
custom families in addition to the Baumgardt package.  This exercise illustrates the process of 
creating a different custom set of model families to illustrate various concepts required to 
accomplish this type of configuration.  Two of the model families in this exercise are derived 
from Baumgardt’s families. 

When mainScript.csh was run in AWIPS-1 to create a localization, AWIPS-1 automatically 
determined which model families were appropriate for a given model and built the Volume 
menus accordingly.  In AWIPS-2, there is no logic to determine the applicability of a family for a 
given model; the local developer or AWIPS focal point must assign models to families manually 
when creating the menus.  As models evolve, you need to periodically revisit which model 
families are appropriate and adjust the menus accordingly. 

Because we’re reorganizing the Volume menu, this exercise references many of the files 
mentioned in the CAVE Overview Module, Part 2.  It may be helpful to review that module 
before proceeding to regain familiarity with the Volume menu structure, shown in Figure 1.  
The Volume menu and the separator named “top” is defined in 
/awips2/cave/plugins/com.raytheon.uf.viz.d2d.ui_*/plugin.xml.  Another plugin.xml (from the 
volume browser plugin, /awips2/cave/plugins/com.raytheon.viz.volumebrowser_*) attaches 
additional separators to define more structure of the Volume Menu.  Because we cannot 
change nor override the plugin.xml files, we have to incorporate this structure in making any 
changes.  The target menu structure is shown in Figure 2.  This menu structure corresponds to 
our sample AWIPS-1 virtualFieldTable.txt.  An excerpt of this virtualFieldTable.txt containing 
only the names and titles of the custom model families is shown in Figure 3.  The details of 
these entries are shown later throughout the exercise.  The basic process of this exercise is to 
create the new menu organization first, and then assign menu entries for the new model 
families to specific display bundles that we will create later.  Essentially, each model family is a 
bundle, and each graphical plot in the model family is a resource (or product layer) in the 
bundle.  Each menu entry in a menu file for a particular model family references the same 
bundle and passes in a variable containing the particular model name. 

Several of the model family plots are designed for the software to choose between one of two 
plots to display (depending on whether or not a particular parameter is produced by a 



CAVE/EDEX Step-By-Step Exercises Exercise 9: Custom Model Families  95 

particular model).  One example of this would be the choice between 300 mb and 250 mb wind 
speed (with 300 mb displayed if it’s available; otherwise, 250 mb is displayed).  For another 
example, a particular model family might want display muCape for 850-300 mb or PBE for the 
surface, depending on which parameter and level combination is available for a particular 
model. This alternative choice can be implemented in CAVE display bundles using the 
firstAvailableResourceData that tells the software to display a resource chosen from a group of 
resources.   Plenty of examples 
follow in the exercise. 

Much of this exercise involves 
editing display bundle (.XML) files 
and replacing existing or adding 
new metadata fields.  One way to 
discover correct metadata fields 
and values for particular model 
fields, model layers, or levels is to 
use the Volume Browser or the 
Product Browser in the D2D 
perspective to load a desired 
parameter for a particular level or layer.  Then use the Save Editor 
Display option in CAVE’s Load/Save Displays menu to save the active 
display bundle into a file.  Then open the saved bundle file in the 
localization perspective (use the File » Open File menu) to view the 
metadata used for that display.  Another handy way to discover the 
metadata for a particular type of data is by using the Product Browser.  
If you navigate through the tree structure in the Product Browser to find a given product, you 
can right-click on the product to either load it or to view product info.  If you choose Product 
Info, a tool-tip appears which contains much of the metadata associated with the given 
product.  

In CAVE, the rotation of product legend colors 
(and corresponding colors of contours, 
vectors, wind barbs, and icon plots) is defined 
in a config.xml file in com.raytheon.viz.core.  
Found under Plugin Configs in the Localization 
Perspective’s File Browser, this file can be 
customized by changing existing colors or 
adding new colors.  The possible color names are defined in /awips2/cave/etc/colorfile/rgb.txt.  
Normally, each resource in a bundle is assigned one of the colors in this config.xml file.  If 



CAVE/EDEX Step-By-Step Exercises Exercise 9: Custom Model Families  96 

appropriate, the resource is drawn using that product (for example, contours, station plots, 
vectors, etc.), and its corresponding legend entry appears using that color, unless the resource 
itself specified a different color (which need not be one of the colors in the config.xml file).   
However, the firstAvailableResourceData just shows its plot and corresponding legend entry in 
green by default.  The next resource in the bundle skips the color that the 
firstAvailableResourceData should have used, so the color order for all other resources is 
preserved.  In other words, when using multiple firstAvailableResourceData resources, to make 
contours, wind barbs, streamlines and other non-image plots distinguishable from one another, 
their colors need to be manually specified in the bundle.  This is done by adding a 
colorableCapability to each resource embedded in the firstAvailableResourceData:  <capability 
xsi:type=“colorableCapability” colorAsString= “{color}”/>.  The examples illustrate adding the 
colorableCapability where needed (indicated using blue boxes in some of the figures).  Since 
these colors are specified manually, the color is your preference.  In these exercises, we’ll just 
continue to cycle through the colors specified in the config.xml file. 

This exercise will take 3 to 3.5 hours to complete. 
 
 Troubleshooting Tip      

Occasionally when editing bundle files, you may wish to comment out whole 
sections of XML code.  The Localization Perspective editor has commands to 
assist with this.  To comment out offending sections, highlight the parts of the 
bundle you need to comment.  Then click the Source menu followed by Add 
Block Comment.  This should put XML comments (“<!- -“) and (“- ->”) around 
the entire section.    

 



CAVE/EDEX Step-By-Step Exercises Exercise 9: Custom Model Families  97 

 
 
Figure 1.  Baseline AWIPS-2 Volume Menu structure.  Separators are defined in the d2d_ui and 
volumebrowser plugin.xml files, while the rest of the structure is defined in the index.xml and base*.xml 
files in the volumebrowser plugin's localization/menus directory. 

Figure 2.  Custom volume menu structure to be constructed in this exercise.   
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Figure 3.  Titles and Names of Model Families in custom AWIPS-1 virtualFieldTable.txt file. 
 
Note:  ModFamU and ModFamV were actually implemented into the AWIPS-2 baseline as part of the Baumgardt 
extensions.  We’re recreating them here because ModFamU illustrates most of the different types of plots that are 
available, and modFamV has an instance of having to choose among two parameters from different levels.  
ModFamHH was implemented at a few WFOs and is an example of a custom 4-panel family.  Finally, the Demo: 
Layers Family is a family that illustrates (for learning purposes, only) a few other concepts related to using 
parameters on nontraditional model layers (potential vorticity, potential temperature, equivalent potential 
temperature, boundary layer, lifted condensation level, etc.)  
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Concept Actions 

Part 1.  Briefing Family:  Reorganize the Volume Menu as a User-level Override  
1. Make a user-level 

copy of the 
volumebrowser 
index.xml menu file 
from which all other 
menus are attached.  

In the Localization Perspective 
file browser, open CAVE » 
Menus » volume.  Right-click 
the BASE icon under index.xml 
and choose  
Copy To ►User. 
 
 

2. Make a user-level 
copy of the 
baseFamilies.xml 
menu file.  In a later 
step, this menu 
contribution will be 
changed from a simple 
include to a pull-out 
menu. 

Right-click the BASE 
icon under 
baseFamilies.xml and 
choose  
Copy To ►User. 
 
 
 
 

3. Edit the index.xml file 
to create the model 
family entries above 
the Comparison 
Families separator.  
These are the pull-out 
menus for 4-Panel 
Families, Basic 
Families, and Briefing 
Families.   

 
Note:  You may have to 
use the tabs at the 
bottom of the 
Localization Perspective 
to alternate between 
the source view and the 
design view. 

Edit the user version of index.xml by double-clicking its USER icon. 
 
Transform the include for baseFamilies.xml into a submenu by 
adding the submenu tag as shown in Box A in Figure 4. 
 
Duplicate the include for the 4-Panel Families submenu (red box in 
Figure 4). 
 
In the first entry for baseFourPanelFamilies.xml, change 
before=Comparison Families to after=VolumeBundles, as shown in 
Box B in Figure 4. 
 
In the second baseFourPanelFamilies entry, change the subMenu to 
“Briefing Families” and the fileName to 
“menus/volume/briefingFamilies.xml” (Box C). 
 
Save your changes. 
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Figure 4.  First edits to index.xml to create the model family entries above the 
ComparisonFamilies separator. 

4. Use baseFamilies.xml 
as a template for the 
new Briefing Families 
menu. 

Make sure you’ve saved your 
edits to index.xml. Copy 
baseFamilies.xml to 
briefingFamilies.xml by right-
clicking on the USER icon 
under baseFamilies.xml and 
choosing  
Copy To ► New File.   
 
Name the new file 
briefingFamilies.xml. 
 
 
 
 
 
 
We’ll change the bundle references inside briefingFamilies.xml later. 
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5. Restart CAVE to see 
your changes reflected 
in the Volume menu.  
The Basic Families and 
4-panel Families menu 
entries should also 
work, since we just 
moved them around 
in the menu structure.  

 

 
6. Change the bundle 

references in the new 
briefingFamilies.xml to 
be appropriate for the  
Briefing Families 
Menu.   

In the Localization Perspective, edit the briefingFamilies.xml menu 
file.  Perform the following edits as shown in Figure 5. 

• Delete the entries for these models:  
o ECMWF-HiRes 
o ECMWF-LowRes 
o arwEast 
o arwWest 
o mmmEast 
o mmmWest 
o UKMET 

We only delete these entries to simplify this exercise.  A similar 
process as illustrated here would be used to create appropriate 
bundles for these models.  In reality, you would just create separate 
bundles for the parameters and layers those models have. 

 
• Change the name of the file for each bundleItem from 

DefaultFamily.xml to BriefingFamily.xml. 
 

LAPS may require considerable configuration for AWIPS-2.  After 
LAPS is operational at your site, you can add a LAPS menu 
contribution by following the pattern already in the file. 
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Figure 5.  Changes to briefingFamilies.xml. 
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Part 2.  Briefing Family:  Implement the display bundle  
7. Create the 

BriefingFamily.xml 
bundle.  We need to 
make the bundle 
reflect the 
BriefingFamily as 
defined by the 
ModFamU entry in 
virtualFieldTable.txt 
(Figure 6) and 
illustrated using 
AWIPS-1 in Figure 7.  
Begin by creating a 
user-level version of a 
BriefingFamily.xml 
bundle by using the 
DefaultFamily.xml as a 
starting point. 

In the Localization 
Perspective File Browser, 
open CAVE » Bundles » 
volume » 
DefaultFamily.xml.  Right-
click BASE and select  
Copy To ►New File.  Name 
the new file 
BriefingFamily.xml.   
 
Switch perspectives to the D2D perspective and verify that the 
Briefing Families pull-out menu from the Volume Menu actually has 
data (at this point, it’s simply a duplicate of the Basic Family).   
 
Most often when modifying bundles (not menus), there is no need 
to restart CAVE to test changes in the bundle. 

  
Figure 6.  Excerpt of virtualFieldTable.txt that defines the Briefing Family.   The interpretation of the 
numeric codes preceding each field and level combination is as follows:  A non-zero value in the ones 
place means this overlay should be toggled on by default. The tens digit is the display type to use: 
0=contour, 1=icons, 2=image, 3=barbs, 4=streamlines, 5=arrows, 6=dualarrows, 7=other. A non-zero 
value in the hundreds digit means start a new pane. The thousands place is number of frames to load; 0 
means the same as the number of forecast times and 99 means whatever the display is currently set for 
(verbatim from AWIPS-1 documentation in /awips/fxa/data/localization/documentation/families.html). 
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Figure 7.  Example of AWIPS-1 Briefing Family display from the NAM80 (top) and an enlarged version of 
the product legend from the RUC80 Briefing Family (bottom). 

8. Modify the 
BriefingFamily bundle 
to display the first two 
parameters (total 
precip and MSL 
pressure). 

 
 

According to Figure 6, the first parameter in the Briefing Family is 
Total Precip (TP).  It’s a contour plot (tens digit is zero) that’s toggled 
off by default (ones digit is zero).  The second parameter (MSL 
Pressure) is a contour plot that is visible by default.   
 
Use the Localization Perspective to edit BriefingFamily.xml.  In the 
first resource, make the following edits (Figure 8): 

• Change isVisible to false (Box A) 
• Change parameter to TP (Box B) 
• Change masterLevel.name to SFC (Box C) 
• Change levelonevalue to 0 (Box D) 
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{TP} was defined as a substitution value in each of menu items in the 
BriefingFamilies.xml file (Figure 5).  It’s also a derived parameter.  
The substitution value is used if the bundle says {TP} and the derived 
parameter is used if the bundle says TP.  
 
The second parameter is a bit more complicated because the Virtual 
Field Table entry (“|1.|msl-P,Surface|msl-P2,Surface\”) says to 
display the first available of the two parameters, either msl-P or msl-
P2.   Both of these are derived parameters.  To verify the correct 
derived parameter name in AWIPS-2, use the File Browser in the 
Localization Perspective.  Click D2D » Derived Parameters » 
definitions, and search through the list.  Most of the AWIPS-1 
derived parameters have kept similar names in AWIPS-2.   
 
In order to have the bundle choose between two parameters to 
display, we need to change the resourceData type from 
gridResourceData to firstAvailableResourceData.  The structure for 
the firstAvailableResourceData resource is: 
 
<resource> 

<loadProperties/> 
<properties/> 
<resourceData xsi:type=”firstAvailableResourceData”> 
     <resource>    (first parameter) 
          <loadProperties xsi:type=”gridLoadProperties”              
                          displayType=”CONTOUR”>   
          </loadProperties> 
          <resourceData xsi:type=gridResourceData … > 
                <metadataMap>   </metadataMap> 
          </resourceData> 
     </resource> 
     <resource>    (second parameter) 
           <loadProperties xsi:type=”gridLoadProperties”  
                           displayType=”CONTOUR”>   
           </loadProperties> 
           <resourceData xsi:type=gridResourceData … > 
                <metadataMap>   </metadataMap> 
           </resourceData> 
     </resource> 
</resourceData> 

</resource> 

 
Note how there are two resources each having a resourceData (one 
for each parameter) embedded inside a larger resourceData, which 
itself is part of a resource.  In this example, both embedded 
resources are contour plots and use gridResourceData, but the 
display types and associated ResourceData types need not be the 
same, and need not be limited to only two.  In other words, in 
AWIPS-2, the firstAvailableResourceData could specify wind barbs, 
arrows or streamlines, or an image, or contour plot.  The AWIPS-1 
virtual field table required the plot type for any alternative to be the 
same. 
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To create this firstAvailableResourceData, add the four lines shown 
in the red box in Figure 9 just below the TP resource.  Note there are 
comments included in this file to indicate the AWIPS-1 virtual field 
table descriptors.  Consider adding these to your file as you go along. 
 
Indent (for readability’s sake) 
the entirety of the next 
resource.  This next resource is 
for 500 MB Absolute Vorticity, 
but we will change it to be msl-
P.  To indent the resource, 
select or highlight the entire 
resource and click the Source 
menu followed by the Shift 
Right option.  The examples shown in this exercise were made by 
doing the Shift Right operation twice. 
 
Change these parameters in the resource just indented (see Figure 
10): 

• ensure isVisible is “true” (Box A) 
• constraintValue for info.parameter.abbreviation to “msl-P” 

(Box B) 
• constraintValue for info.level.masterLevel.name to “SFC” 

(Box C) 
• constraintValue for info.level.levelonevalue to “0.0”. (Box D) 

 
Add <capability xsi:type=“colorableCapability” 
colorAsString=“coral”/> to the capabilities under loadProperties 
(blue box in Figure 10). 
 
Use the next resource (it was originally for msl-P) to become the 
second <resource> of the firstAvailableResourceData.  Indent this 
resource and make these changes: 

• In the properties tag, change isVisible to true” (Box A in 
Figure 11). 

• For info.parameter.abbreviation, change the constraintValue 
to “msl-P2”.  Verify the constraintType is “EQUALS” (Box B in 
Figure 11). 

• For info.level.masterLevel.name, verify the constraintValue is 
“SFC” (Box C in Figure 11). 

• For info.level.levelonevalue, verify the constraintValue is 
“0.0” (Box D in Figure 11). 
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Add <capability xsi:type=“colorableCapability” 
colorAsString=“coral”/> to the capabilities under loadProperties 
(blue box in Figure 11). 
 
After the closing </resource> tag of the msl-P2 resource, add closing 
</resourceData> and </resource> tags (for the 
firstAvailableResourceData; the red box in Figure 11). 

 
Figure 8.  Edits to the first resource in BriefingFamilies.xml to add the total precipitation (TP) parameter. 
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Figure 9.  Four lines pre-pended to a group of resources to create a firstAvailableResourceData. 

 
Figure 10.  Edits to change the 500 MB AV resource into the surface MSL-P resource.  This is the first 
resource embedded inside the firstAvailableResourceData. 
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Figure 11.  Edits to the BriefingFamilies.xml bundle to add msl-P2 for as the second choice for the 
firstAvailableResourceData for the second layer of the model family. 

9. Test our changes by 
loading the Briefing 
Family from the 
Volume menu in the 
D2D perspective.  
You may have to 
restart CAVE when 
you first test, but in 
many cases when you 
test a change to a 
bundle, you need 
only reload it from 
the menu. 

 
 
 
Tip:  You may wish to test all 
alternatives in a 
firstAvailableResourceData by temporarily setting a 
parameter.abbreviation to a nonsensical value (e.g., NaN) to force 
the other alternative to display.   

10. Add the third through 
sixth parameters to 
the model family, all 
precip-type plots.   

Using the “decoder ring” in Figure 6, the third through sixth layers in 
the model families are precipitation type plots.  The “10” as the plot 
type means that they are icon plots that are toggled off by default.  
Like the msl-P/msl-P2 plot we just finished, each one of precip-type 



CAVE/EDEX Step-By-Step Exercises Exercise 9: Custom Model Families  110 

 

 

plots can choose between either PTyp or Snow3, Fzra2, Mix2, or 
Rain3.  This means that the plot would be created in a similar fashion 
as the msl-P/msl-P2 plot using the firstAvailableResourceData. 
 
To make the PTyp|Snow3 plot, we’ll re-use the resource for the 
previous msl-P/msl-P2 plot (it used the firstAvailableResourceData).  
Copy and paste that entire plot (approximately lines 42-118) to 
duplicate it.   Make the following edits (Figure 12): 

• Add the isVisible=”false” tag to the <properties/> of the 
firstAvailableResourceData container (Box A) 

• In the first embedded resource,  
o Change the displayType from “CONTOUR” to “ICON” 

(Box B) 
o Change the colorAsString to “cyan” (Box C) 
o In the properties, add renderingOrderId=“CONTOUR” 

(Box D).  Adding this property makes CAVE treat this 
icon plot as a contour plot for purposes of 
determining the drawing (layering) order.  If we had 
left this out, the icon plot would be placed as the top 
layer of the model family (i.e., drawn after all the 
contour plots). 

o Change isVisible to “false” (Box E) 
o Change the constraintValue for the 

parameter.abbreviation to “PTyp” (Box F) 
o Because the previous plot was Sea Level Pressure and 

this precip type is also valid at the surface, all the 
level parameters are unchanged. 

• In the second embedded resource, make similar changes: 
o Change the displayType to “ICON” (Box G). 
o Change the colorAsString to “cyan” (Box H) 
o Add renderingOrderId=”CONTOUR” to the properties 

(Box I) 
o Set isVisible to “false” (Box J) 
o Set the parameter.abbreviation value to “Snow3” 

(Box K)   
 
NOTE:  The Snow3 parameter is actually based on critical thickness 
values.  If you wish, you can change the Snow3 resource back to 
CONTOUR rather than ICON if you desire a more quantitative 
display.  This capability (having alternative plots of different types) 
was not possible in AWIPS-1. 
 
For the next plot (PTyp | Frza2), duplicate the (PTyp | Snow3) plot.  
Make these changes in the new plot (Figure 13): 
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• Set both instances of colorAsString to “burlywood”. 
• Change the parameter.abbreviation in the second embedded 

resource from “Snow3” to “Frza2” 
 
For the next plot (PTyp | Mix2), duplicate the (PTyp | Frza2) plot.  
Make these changes in the new plot: 

• Set both instances of colorAsString to “yellow”. 
• Change the parameter.abbreviation in the second embedded 

resource from “Frza2” to “Mix2” 
 
For the next plot (PTyp | Rain3), duplicate the (PTyp | Mix2) plot.  
Make these changes in the new plot: 

• Set both instances of colorAsString to “violet”. 
• Change the parameter.abbreviation in the second embedded 

resource from “Mix2” to “Rain3” 
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Figure 12.  Edits to BriefingFamily.xml to add the Precip Type/Snow3 icon plot. 
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Figure 13.  Edits to BriefingFamily.xml to add the Precip Type/Fzra2 icon plot. 

11. Add the seventh layer 
to the model family, 
surface wind barbs.   

 

The next layer in the model family is a plot of surface wind barbs, 
toggled off by default.  Creating this plot layer is a relatively simple 
change to the next resource in BriefingFamilies.xml (originally a 
contour plot for 1000-500 mb thickness, or dZ).  Make the following 
changes as shown in Figure 14: 

• In the loadProperties, change the displayType from 
“CONTOUR” to “BARB” (Box A) 

• In the properties, ensure isVisible is “false”. 
• In the metadataMap for info.parameter.abbreviation, change 

the constraintValue from “dZ” to “Wind” (Box B) 
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• Change the constraintValue for  info.level.leveltwovalue is  
“-999999” (Box C) 

• Change the constraintValue for info.level.masterLevel.name 
from “MB” to “SFC” (Box D) 

• Change the constraintValue for info.level.levelonevalue  to 
“0.0” (Box E) 

 
Figure 14.  Edits to BriefingFamily.xml to add surface wind barbs. 

12. Test by reloading the 
Briefing Family option 
from the Volume 
menu for an available 
model. 
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13. Add the 1000-850 mb 
Fn Vector or Q-vector 
divergence plots.  
This is a contour plot, 
and is defaulted to be 
invisible.  This plot 
should use the 
firstAvailableResourc
eData to choose 
between DivFn and 
qDiv.   

 
 

Just below the resource in Figure 13 for the Surface Wind Barbs, add 
the four lines indicated in Figure 9 that begin a resource containing a 
firstAvailableResourceData. 
 
Because this contour plot should initially not be visible, change 
properties of the firstAvailableResourceData like the following:

 
Transform the next pre-existing resource (700 mb height, or GH) into 
the resource for 1000-850 mb DivFn by doing the following: 
 

• Indent the entire 700 mb GH resource. 
• Change the constraintValue for 

minfo.parameter.abbreviation to “DivFn” 
• Ensure the constraintValue for info.level.masterLevel.name is 

“MB” 
• Change the constraintValue for info.level.levelonevalue is 

“1000.0” 
• Set the constraintValue for the info.level.leveltwovalue to 

“850.0” 
 

Add <capability xsi:type=“colorableCapability” 
colorAsString=“OrangeRed”/> to the capabilities under 
loadProperties. 
 
Use the next resource (1000-500 mb RH) for the qDiv resource.   

• Indent the entire 1000-500 mb RH resource. 
• Change the constraintValue for info.parameter.abbreviation 

to “qDiv” 
• Ensure the constraintValue for info.level.masterLevel.name is 

“MB” 
• Verify the constraintValue for info.level.levelonevalue to 

“1000.0” 
• Set the constraintValue for the info.level.leveltwovalue to 

“850.0” 
 
Add <capability xsi:type=“colorableCapability” 
colorAsString=“OrangeRed”/> to the capabilities under 
loadProperties. 
 
Add closing </resourceData> and </resource> tags below the closing 
</resource> tag for the qDiv resource. 
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14. Test 

 
15. Add the 850 mb 

Mmag and MTV plots.  
The MTV (Moisture 
Transport Vectors) 
plot is represented as 
an arrow plot, so the 
displayType for that 
resource is changed 
from CONTOUR to 
ARROW.   

The next pre-existing resource in the BriefingFamilies.xml should be 
700 mb PVV.  Make the following changes to that resource to create 
the 850 mb Mmag (Moisture Transport Magnitude) contour plot:   

• Change the constraintValue for the 
info.parameter.abbreviation to “Mmag” 

• Change the constraintValue for the info.level.levelonevalue 
to “850.0” 

• Ensure that the value for info.level.leveltwovalue is  
“-999999”. 

• Ensure that the value for the info.level.masterLevel.name is 
“MB”. 

 
The next (last) resource in the BriefingFamilies.xml bundle should be 
{TP} (total precipitation at the surface).  Make the following changes 
to the {TP} resource: 

• In the loadProperties, change the displayType from 
“CONTOUR” to “ARROW”. 

• Change the constraintValue for the 
info.parameter.abbreviation from “{TP}” to “MTV”. 

• Change the constraintValue for the info.level.levelonevalue 
to “850.0”. 

• Change the constraintValue for the 
info.level.masterLevel.name from “SFC” to “MB”. 

• Add a constraint for info.level.leveltwovalue, by copying and 
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pasting the three lines that constitute the levelonevalue, 
changing it to leveltwovalue, and setting the constraintValue 
to “-999999”. 

 
At this point, we have run out of the pre-existing resources in 
BriefingFamilies.xml, so we’ll just keep copying and pasting existing 
resources to the bottom of the resource list (just above the 
timeMatcher tag).   
 

16. Test 

 
17. Add the next three 

layers to the 
modelFamily (qDiv 
contours for 850-700 
mb, qDiv contours for 
700-500 mb, and a 
qDiv image for 700-
500 mb with the 
image visible by 
default.   

 

Since we’re run out of pre-existing resources to modify, we’ll 
copy/paste a copy of the Mmag resource to use for the 850-700 mb 
qDiv contour plot.  We use the Mmag because it’s already an 
invisible contour plot just like what’s needed for the next plot.  Make  
these changes to the new resource:  

• Change the constraintValue for the 
info.parameter.abbreviation to “qDiv”. 

• Change the constraintValue for the info.level.leveltwovalue 
to “700.0”. 

• Ensure the constraintValue for the info.level.levelonevalue  is 
“850.0”. 

 
Paste a copy of the 850-700 mb qDiv resource we just made to use 
for the 700-500 mb qDiv contour plot, and make these changes:  

• Change the constraintValue for the info.level.levelonevalue 
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to “700.0”. 
• Change the constraintValue for the info.level.leveltwovalue 

to “500.0”. 
 
To make the 700-500 mb qDiv image plot, copy and paste the entire 
700-500 mb qDiv resource we just edited.  In the second version, 
change the displayType from “CONTOUR” to “IMAGE”, and isVisible 
to “true”.   
 
Note:  One difference between AWIPS-1 (Figure 7) and AWIPS-2 is 
that the qDiv image in AWIPS-1 could be in the middle of the 
product legend and still be drawn at the bottom of the plot (so that 
the map background and other contour, icon, arrow, and streamline 
plots were still visible on top of the image).   The AWIPS-2 product 
legend is essentially a representation of the drawing order of the 
graphic, so the image is automatically placed at the bottom of the 
legend, unless a renderingOrderId value other than 
“IMAGE_REGION” is  specified in the image properties.  If you desire 
the image to not be at the bottom, then you may need to specify 
alpha channel (transparency) settings so that plots under the image 
can be seen.  

18. Test 

 



CAVE/EDEX Step-By-Step Exercises Exercise 9: Custom Model Families  119 

19. Add a 
firstAvailableResource
Data to implement the 
next DivFn contour 
plot.  

Copy the previous firstAvailableResourceData used to make the 
1000-850 mb DivFn / qDiv plot in Step 13 (it’s at approximately lines 
465-544) and paste it just below the resource you just edited for the 
700-500 mb qDiv image. 
 
In the first embedded resource, make these changes: 

• Change leveltwovalue to “600.0”. 
• Change levelonevalue to “700.0”. 
• Verify the other fields are correct: 

o parameter.abbreviation = DivFn 
o masterLevel.name = MB 

• In the colorableCapability, set the colorAsString to “yellow”. 
 

In the second resource, make these changes: 
• Change parameter.abbreviation to “DivFn”. 
• Change leveltwovalue to “500.0”. 
• Change levelonevalue to “700.0”. 
• Verify that masterLevel.name = “MB”. 
• In the colorableCapability, set the colorAsString to “yellow”. 

 
Note:  This DivFn contour plot is to be invisible by default.  Thus, the 
properties of the firstAvailableResourceData and the two embedded 
resources all should include an isVisible=”false” tag, which should 
automatically occur by virtue of reusing the 
firstAvailableResourceData from Step 13.  

20.   Test 
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21. Add the next two 
plots (500 mb GH, and 
1000-500 mb RH). 

To make the 500 mb GH contour plot, copy and paste the last 
regular resource (the 700-500 mb qDiv image) above the 
firstAvailableResourceData resource from Step 19, and make the 
following changes: 

• Change the displayType from “IMAGE” to “CONTOUR” 
• Change isVisible to “false” 
• Change the parameter.abbreviation to “GH” 
• Change the levelonevalue to “500.0” 
• Change the leveltwovalue to “-999999”  

 
Copy and paste the 500 mb height contour plot we just made.  In the 
new copy, make the following changes to make the 1000-500 mb RH 
contour plot: 

• Change the parameter.abbreviation to “RH” 
• Change levelonevalue to “1000.0” 
• Change leveltwovalue to “500.0” 

 
22. Test 

 
23. Implement the next 

plot in the bundle 
which is either 500 
mb absolute vorticity 
(AV) or 500 mb 
geostrophic vorticity  
(geoVort).  This plot 
has to use the 

Copy and paste the last resource that used 
firstAvailableResourceData (it was for DivFn for either the 700-600 
MB or 700-500 mb layers at approximately lines 731 to 810).  Make 
the following changes: 

• Ensure the isVisible tag is set to “false” in the <properties/> 
line of the firstAvailableResourceData. 
 

• In the first (DivFn for 700 - 600 MB) resource: 
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firstAvailableResource
Data. 

o Ensure isVisible=“false” 
o Change the parameter.abbreviation to “AV” 
o Ensure the masterLevel.name is “MB” 
o Change the levelonevalue to “500.0” 
o Set the leveltwovalue to “-999999”. 
o Set the colorAsString to “OrangeRed”/> in the 

colorableCapability under loadProperties. 
 

• In the second (DivFn for 700-500 MB) resource: 
o Ensure isVisible=“false” 
o Change the parameter.abbreviation to “geoVort” 
o Ensure the masterLevel.name is “MB” 
o Change the levelonevalue to “500.0” 
o Set the leveltwovalue to “-999999”. 
o Set the colorAsString to “OrangeRed”/> in the 

colorableCapability under loadProperties. 
 

 
24. Make the 500-300 mb 

PTvA (Potential 
Vorticity Advection) 
plot.  Since this a 
simple resource, we’ll 
reuse the 1000-500 
mb RH contour plot. 

 

Copy and paste the resource for the 1000-500 mb RH plot (this may 
be at approximately lines 850-884).  Place it just below the resource 
for the 500 mb AV/geoVort plot.  Make the following changes: 

• Change the parameter.abbreviation to “PTvA” 
• Change levelonevalue to “500.0” 
• Change leveltwovalue to “300.0” 

 

25. Test 
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26. Make the final three 
wind plots (wind 
speed, wind vectors, 
and divergence for 
either 300 or 250 
mb).  All three of 
these have to use 
firstAvailableResourc
eData, and all three 
are initially set to not 
visible, similar to the 
the 500 mb 
AV/geoVort plots.  

Copy and paste the entire resource used for the 500 mb AV/geoVort 
contour plot (it’s at approximately lines 887-966).  Make the 
following changes: 

• In the first embedded (AV) resource: 
o Change the parameter.abbreviation to “wSp” 
o Change the levelonevalue to “300.0” 
o Set the colorAsString to “green” in the 

colorableCapability under loadProperties. 
 

• In the second (geoVort) metadata map: 
o Change the parameter.abbreviation to “wSp” 
o Change the levelonevalue to “250.0” 
o Set the colorAsString to “green” in the 

colorableCapability under loadProperties. 
 
Test this addition by reloading the bundle in CAVE.  For the next plot, 
it is a streamline plot of the vector wind.  Copy and paste the entire 
wSp plot we just created.  In the second copy, change the two 
instances of displayType from “CONTOUR” to “STREAMLINE”, the 
two instances of “wSp” to “Wind”, and the two instances of 
colorAsString to “coral”. 
 
To make the final plot of divergence, copy and paste the wSp 
contour plot again.  In this version, just change both instances of 
“wSp” to “wDiv”, and both instances of colorAsString to “cyan”. 

27. Test 
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28. Optional:  Add 
bundles for the 
UKMET and the 
ECMWF 

For further practice, consider adding bundles for the UKMET and 
ECMWF models.  The names of the bundles are already defined in 
our briefingFamilies.xml menu file (Figure 5).  Use the Product 
Browser to find the available products from these models that are 
analogous to the parameters specified in the BriefingFamily.xml 
bundle file we just edited. You’ll likely find parameters or levels that 
are not available.  The specific model (e.g., ECMF1, ECMF2, etc) used 
will depend on your specific geographic sector. 

Part 3.  Conv: Severe Type Families Menu 
29. Use the 

briefingFamilies.xml 
menu as a template 
for the Conv: Severe 
Type Families menu 
to be called 
convSvrTypeFamilies.
xml. Add the new 
menu to the Volume 
menu.  Change the 
bundle references in 
the new 
convSvrTypeFamilies.
xml to be appropriate 
for the Severe Type 
Families Menu. 

In the Localization Perspective 
file browser, open CAVE » 
Menus » volume.  Copy 
briefingFamilies.xml to 
convSvrTypeFamilies.xml, by 
clicking the USER icon under 
briefingFamilies.xml and 
choosing Copy To ►New File.  
Name the new file 
convSvrTypeFamilies.xml.   
 
 
 
Edit the user version of the index.xml menu file (CAVE » Menus » 
Volume » index.xml) by double-clicking its USER icon.  Add an entry 
for the Conv: Severe Type Families as indicated in Figure 15.  Save 
your changes. 
 
We’ll change the bundle references next. 
Edit convSvrTypeFamilies.xml and change the menuText in the 
subMenu from “Briefing Families” to “Conv: Severe Type Families”. 
 
Change the name of the file for each bundleItem from 
BriefingFamily.xml to ConvSvrTypeFamily.xml (see Figure 16). 
 
Save your changes. 
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Figure 15.  Changes to index.xml to add the Conv: Severe Type Family submenu. 
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Figure 16.  Changes to the ConvSvrTypeFamilies.xml menu file. 

30. Duplicate the 
BriefingFamily.xml 
bundle file created in 
Part 2 as 
ConvSvrTypeFamily.xml, 
so that the menu 
entries created above 
will work. 

In the File Browser, scroll up to 
the CAVE » Bundles section.   
Open volume and 
BriefingFamily.xml.  Right-click 
the USER icon and choose 
Copy To ►New File.  Call the 
new file ConvSvrTypeFamily.xml 
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31. Restart CAVE to see 
your changes 
reflected in the 
Volume menu.  The 
Conv: Severe Type 
Families menu should 
be located above 
Surface Families and 
should display the 
models declared in 
the 
convSvrTypeFamilies.x
ml menu file. 

 
 

Part 4. Implement the Conv: Severe Type Families Bundle 
32. We need to make the 

bundle reflect the 
Conv: Severe Type 
Family as defined by 
the ModFamV entry 
in 
virtualFieldTable.txt 
(Figure 17). We’ll 
start by modifying the 
bundle to display the 
first three parameters 
(total precipitation, 
MSL pressure, and 
wind). 

Edit the new USER version of the ConvSvrTypeFamily.xml bundle.  
The first resource in the bundle for TP needs no changes. 
 
It’s probably also acceptable to leave the second 
(firstAvailableResourceData for msl-P and msl-P2) resource alone, 
except to change the two instances of isVisible to “false” and to add 
isVisible=”false” to the firstAvailableResourceData properties. 

 
 
Optional:  If you want to make the bundle only reference msl-P 
rather than including the msl-P2 in the firstAvailableResourceData, 
then delete the lines indicated in Figure 18. 
 
The next four resources in the bundle are all PTyp icon plots.  After 
that the next resource is surface wind barbs which is the next plot 
needed for the Convective Severe Type Family bundle, so delete the 
entire set of PTyp resources. 
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Figure 17.  Excerpt of virtualFieldTable.txt that defines the Conv: Severe Type Family.   The 
interpretation of the numeric codes preceding each field and level combination is as follows:  A non-zero 
value in the ones place means this overlay should be toggled on by default. The tens digit is the display 
type to use: 0=contour, 1=icons, 2=image, 3=barbs, 4=streamlines, 5=arrows, 6=dualarrows, 7=other. A 
non-zero value in the hundreds digit means start a new pane. The thousands place is number of frames 
to load; 0 means the same as the number of forecast times and 99 means whatever the display is 
currently set for (verbatim from AWIPS-1 documentation in 
/awips/fxa/data/localization/documentation/families.html). 
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Figure 18.  Optional lines to delete from msl-P/msl-P2 firstAvailableResourceData to make it a simple 
msl-P resource. 
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33. Test 

 
34.  Add the next two 

resources to the 
model family (cCape 
for the mixed layer 
and either cCin for 
the mixed layer or 
negative buoyant 
energy for the 
surface). 

The next resource already present in the bundle file is a 
firstAvailableResourceData for DivFn or qDiv.  We have a simple 
resource to do first, so we’ll copy/paste the Wind resource just 
above and change it for cCape.  Then we’ll use the 
firstAvailableResourceData for the cCin/NBE resource.  
 
Duplicate the wind barb resource by copying and pasting it. As of 
OB13.5.1, the ML designation doesn’t work (AWIPS2_DR_13194; 
trying to use that layer results in a No Data Available message in 
AlertViz), so we’ll use a 0-1 km FHAG (Fixed Height Above Ground) 
layer instead. Make these changes to the bundle: 

• Change the displayType from “BARB” to “CONTOUR”. 
• Change the constraintValue for the 

info.parameter.abbreviation from “Wind” to “cCape” 
• Change the constraintValue for the info.level.leveltwovalue 

from “-999999” to “1000.0” 
• Change the constraintValue for the 

info.level.masterLevel.name from “SFC” to “FHAG” 
• Ensure the constraintValue for the info.level.levelonevalue is 

“0.0” 
 
Now change the next (firstAvailableResourceData) resource to 
choose between 0-1km FHAG cCin or NBE at the surface .  In the first 
embedded resource: 

• Change the colorAsString to “yellow” 
• Change the constraintValue for the 

info.parameter.abbreviation from “DivFn” to “cCin” 
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• Change the constraintValue for the info.level.leveltwovalue 
from “850.0” to “1000.0” 

• Change the constraintValue for the 
info.level.masterLevel.name from “MB” to “FHAG” 

• Change the constraintValue for the info.level.levelonevalue 
from “1000.0” to “0.0” 

In the second embedded resource: 
• Change the colorAsString to “yellow”  
• Change the constraintValue for the 

info.parameter.abbreviation from “qDiv” to “NBE” 
• Change the constraintValue for the info.level.leveltwovalue 

from “850.0” to “-999999” 
• Change the constraintValue for the 

info.level.masterLevel.name from “MB” to “SFC” 
• Change the constraintValue for the info.level.levelonevalue 

from “1000.0” to “0.0” 
 

35. Test 

 
36. Add the next three 

resources, for PBE at 
the surface, and then 
a contour and image 
of 0-6km Bulk Shear 
Magnitude. 

First, we’ll change the next existing resource in the file (850 Mmag) 
to Surface PBE. 

• Change the constraintValue for the 
info.parameter.abbreviation from “Mmag” to “PBE” 

• Change the constraintValue for info.level.masterLevel.name 
from “MB” to “SFC” 

• Change the constraintValue for the info.level.levelonevalue 
from “850.0” to “0.0”  

• Verify the constraintValue for the info.level.leveltwovalue  is 
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“-999999”. 
 
Now, we will add the 0-6 km bulk shear contours to the D2D display.  
The existing plot was an arrow plot for 850 mb moisture transport 
vectors. 

• Change the displayType from “ARROW” to “CONTOUR” 
• Change the constraintValue for the 

info.parameter.abbreviation from “MTV” to “BlkMag” 
• Change the constraintValue for the 

info.level.masterLevel.name from “MB” to “FHAG” 
• Change the constraintValue for the info.level.levelonevalue 

from “850.0” to “0.0” 
• Change the constraintValue for the info.level.leveltwovalue 

from “-999999” to “6000.0” 
 
The next plot we need is an image version of the contour plot we 
just made, so just copy/paste the previous resource, and make these 
two changes: 

• Change the displayType from “CONTOUR” to “IMAGE” 
• Change isVisible to “true” 

 
37. Test 
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38. Now add the three 
layers of BlkMag 
and/or EHI contours. 

The next layer we need to construct is a firstAvailableResourceData 
to choose between either Bulk Shear Magnitude contours or EHI 
contours for 0-3 km AGL.  We will encapsulate the next two existing 
resources in our bundle in the firstAvailableResourceData. 
 
Add the four lines indicated by the black box in Figure 19 between 
the 0-6km AGL BlkMag image we just did and the next pre-existing 
resource in the bundle (850-700MB qDiv contours). 
 
Indent the two resources to be embedded inside the 
firstAvailableResourceData (currently 850-700MB qDiv contours and 
700-500MB qDiv contours).   
 
Add closing </resourceData> and </resource> tags after the 
resource for 700-500MB qDiv contours. 
 
In the first embedded resource (850-700MB qDiv contours), make 
the following changes: 

• Add <capability xsi:type=“colorableCapability” 
colorAsString=“OrangeRed”/> to the capabilities under 
loadProperties  

• Change the constraintValue for the 
info.parameter.abbreviation from “qDiv” to “BlkMag” 

• Change the constraintValue for the 
info.level.masterLevel.name from “MB” to “FHAG” 

• Change the constraintValue for the info.level.levelonevalue 
from “850.0” to “0.0” 

• Change the constraintValue for the info.level.leveltwovalue 
from “700.0” to “3000.0” 

 
In the second embedded resource (700-500MB qDiv contours), make 
the following changes: 

• Add <capability xsi:type=“colorableCapability” 
colorAsString=“OrangeRed”/> to the capabilities under 
loadProperties  

• Change the constraintValue for the 
info.parameter.abbreviation from “qDiv” to “EHI” 

• Change the constraintValue for the 
info.level.masterLevel.name from “MB” to “FHAG” 

• Change the constraintValue for the info.level.levelonevalue 
from “700.0” to “0.0” 

• Change the constraintValue for the info.level.leveltwovalue 
from “500.0” to “3000.0” 
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Use the next pre-existing resource (700-500 MB qDiv image) for 3-
6km AGL BlkMag contours.  Make these changes: 

• Change the displayType from “IMAGE” to “CONTOUR” 
• Change isVisible to “false” 
• Change the constraintValue for the 

info.parameter.abbreviation from “qDiv” to “BlkMag” 
• Change the constraintValue for the 

info.level.masterLevel.name from “MB” to “LYRFHAG” 
• Change the constraintValue for the info.level.levelonevalue 

from “700.0” to “3000.0” 
• Change the constraintValue for the info.level.leveltwovalue 

from “500.0” to “6000.0” 
 
Note:  For a layer product (AGL), look in the LevelMappingFile.xml 
(seen in the Localization Perspective under D2D » Volume Browser) 
file to determine if the masterLevel.name constraintValue should be 
FHAG (fixed height above ground) or LYRFHAG.  If the layer 
coordinate is specified incorrectly, a “No Data Available” message 
will likely appear in AlertViz when CAVE tries to load the bundle. 
The next pre-existing resource in the bundle should be a 
firstAvailableResourceData that includes 600-700 MB DivFn and 500-
700 MB DivFn.  Delete the entirety of the firstAvailableResourceData 
including the two embedded DivFn plots. 
 
Use the next pre-existing resource (500 MB GH contours) for 1-3km 
AGL BlkMag contours.  Make these changes: 

• Change the constraintValue for the 
info.parameter.abbreviation from “GH” to “BlkMag” 

• Change the constraintValue for the 
info.level.masterLevel.name from “MB” to “LYRFHAG” 

• Change the constraintValue for the info.level.levelonevalue 
from “500.0” to “1000.0” 

• Change the constraintValue for the info.level.leveltwovalue 
from “-999999” to “3000.0” 
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Figure 19.   Lines added to begin the firstAvailableResourceData needed for the BlkMag/EHI contours in 
Step 38. 

39. Test 
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40. Add the next five 
layers:   Bulk Shear 
vectors for 0-6 km, 0-
3 km, 3-6 km, 0-1 km, 
and 1-3 km. 

Use the next pre-existing resource (1000-500 MB RH) and make the 
following changes: 

• Change the displayType from “CONTOUR” to “ARROW” 
• Change isVisible to “true” 
• Change the constraintValue for the 

info.parameter.abbreviation from “RH” to “BlkShr” 
• Change the constraintValue for the 

info.level.masterLevel.name from “MB” to “FHAG” 
• Change the constraintValue for the info.level.levelonevalue 

from “1000.0” to “0.0” 
• Change the constraintValue for the info.level.leveltwovalue 

from “500.0” to “6000.0” 
 
The next pre-existing resource is a firstAvailableResourceData for  
500 MB AV/geoVort.  Delete the first four lines (<resource>, 
<loadProperties>, <properties>, and <resourceData> tags), and un-
indent the 500 MB AV resource.  Make these changes to the 500 MB 
AV resource: 

• Change the displayType from “CONTOUR” to “ARROW” 
• Delete the entire colorableCapability line. 
• Change the constraintValue for the 

info.parameter.abbreviation from “AV” to “BlkShr” 
• Change the constraintValue for the 

info.level.masterLevel.name from “MB” to “FHAG” 
• Change the constraintValue for the info.level.levelonevalue 

from “500.0” to “0.0” 
• Change the constraintValue for the info.level.leveltwovalue 

from “-999999” to “3000.0” 
 
Un-indent the next (500 MB geoVort) resource.  Make these changes 
to the 500 MB geoVort resource: 

• Change the displayType from “CONTOUR” to “ARROW” 
• Delete the entire colorableCapability line. 
• Change the constraintValue for the 

info.parameter.abbreviation from “geoVort” to “BlkShr” 
• Change the constraintValue for the 

info.level.masterLevel.name from “MB” to “LYRFHAG” 
• Change the constraintValue for the info.level.levelonevalue 

from “500.0” to “3000.0” 
• Change the constraintValue for the info.level.leveltwovalue 

and set the constraintValue to “6000.0” 
 
Delete the last <resourceData> and </resource> tags that were 
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remaining from the firstAvailableResourceData. 

Transform the next resource (500-300 MB PTvA) into 0-1 km Bulk 
Shear Vectors.  Make these changes to the 500-300 MB PTvA 
resource: 

• Change the displayType from “CONTOUR” to “ARROW” 
• Change the constraintValue for the 

info.parameter.abbreviation from “PTvA” to “BlkShr” 
• Change the constraintValue for the 

info.level.masterLevel.name from “MB” to “FHAG” 
• Change the constraintValue for the info.level.levelonevalue 

from “500.0” to “0.0” 
• Change the constraintValue for the info.level.leveltwovalue 

from “300.0” to “1000.0” 
 
The next pre-existing resource is a firstAvailableResourceData for  
300/250 MB wSp.  Delete the first four lines (<resource>, 
<loadProperties>, <properties>, and <resourceData> tags), and un-
indent the 300 MB wSp resource.  Make these changes to the 300 
MB wSp resource: 

• Change the displayType from “CONTOUR” to “ARROW” 
• Delete the colorableCapability line. 
• Change the constraintValue for the 

info.parameter.abbreviation from “wSp” to “BlkShr” 
• Change the constraintValue for the 

info.level.masterLevel.name from “MB” to “LYRFHAG” 
• Change the constraintValue for the info.level.levelonevalue 

from “300.0” to “1000.0” 
• Change the constraintValue for the info.level.leveltwovalue 

from “-999999” to “3000.0” 
 

Delete the last <resourceData> and </resource> tags that are at the 
end of the 250 mb wSp resource.  
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41. Test 

 
42. Add the next two 

layers:   Vorticity 
Generation 
Parameter (VGP) for 
0-2 km and Most 
Unstable CAPE for 0-4 
km. 

Transform the 250 MB wSp contour resource into the 0-2 km VGP 
contour plot.  Make these changes to the 250 MB wSp resource: 

• Unindent the resource 
• Delete the colorableCapability line. 
• Change the constraintValue for the 

info.parameter.abbreviation from “wSp” to “VGP” 
• Change the constraintValue for the 

info.level.masterLevel.name from “MB” to “FHAG” 
• Change the constraintValue for the info.level.levelonevalue 

from “250.0” to “0.0” 
• Set the info.level.leveltwovalue and set it to “2000.0” 

 
The next pre-existing resource is a firstAvailableResourceData for  
300/250 MB streamlines.  Delete the first four lines (<resource>, 
<loadProperties>, <properties>, and <resourceData> tags), and un-
indent the 300 MB streamline resource.  Make these changes to the 
300 MB streamline resource: 

• Unindent the 300 MB streamline resource 
• Change the displayType from “STREAMLINE” to “CONTOUR” 
• Delete the colorableCapability line. 
• Change the constraintValue for the 

info.parameter.abbreviation from “Wind” to “muCape” 
• Change the constraintValue for the 

info.level.masterLevel.name from “MB” to “FHAG” 
• Change the constraintValue for the info.level.levelonevalue 

from “300.0” to “0.0” 
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• Change the constraintValue for the info.level.leveltwovalue 
from “-999999” to “4000.0” 
 

Delete the next resource (250 MB streamlines) including both sets of 
the  <resourceData> and </resource> tags that are at the end of the 
250 MB streamline resource.  
 
The next resource is a firstAvailableResourceData that is not needed, 
so it can be deleted in its entirety. 
 
Six lines should remain at the bottom of the bundle: 
<timeMatcher xsi:type=”d2dTimeMaqtcher”..../> 
<numberofFrames>${frameCount}</numberofFrames> 
</descriptor> 
</displays> 
<displayList> 
</bundle> 

43. Test 

 

Part 5.  Implement the Conv: Derecho Family Menu 
44. The Derecho Family is 

a four-panel family, 
so use the 
baseFourPanelFamilie
s.xml menu as a 

In the Localization Perspective file 
browser, open CAVE » Menus » volume.  
Copy baseFourPanelFamilies.xml to 
convDerechoFamilies.xml, by clicking the 
BASE icon under 
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template for the 
Conv: Derecho 
Families menu.  It’s a 
four-panel family 
because the numeric 
descriptors in its 
Virtual Field Table 
definition (Figure 22) 
contain three digits. 

baseFourPanelFamilies.xml and choosing Copy To ►New File.  
Name the new file convDerechoFamilies.xml. 

Edit the new convDerechoFamilies.xml menu file. Change the name 
of the file for each bundleItem from “DefaultFourPanel” to 
“ConvDerecho4PFamily.xml”. Delete the ECMWF and UKMET entries 
(see Figure 20). 

 
Figure 20.  Changes to the ConvDerechoFamilies.xml menu file. 

45. Edit the index.xml 
menu file to create 
the convective 
derecho model family 

Edit the user version of index.xml by double-clicking its USER icon. 
 
Duplicate the entry for ConvSvrTypeFamilies.xml and change the 
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entry above the 
Convective Severe 
Types Families entry.   

second version to match the red box in Figure 21. 

 

46. Duplicate the 
DefaultFourPanel.xml 
bundle file as 
ConvDerecho4PFamil
y.xml, so that the 
menu entries created 
above will work. 

In the File Browser, scroll up to 
the CAVE » Bundles section.   
Open volume and 
DefaultFourPanel.xml.  Right-
click the BASE icon and choose 
Copy To ►New File.  Call the 
new file 
ConvDerecho4PFamily.xml. 

Figure 21.  Edits to index.xml to create the Convective Derecho Four-Panel family menu entry. 
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47. Restart CAVE to see 
your changes 
reflected in the 
Volume menu.  The 
Conv: Derecho 
Families menu should 
be located above 
Severe Type Families 
and should display 
the models declared 
in the 
convDerechoFamilies.
xml menu file. 

 

Part 6. Implement the Conv: Derecho Families Bundle 
48. Inspect the 

ConvDerecho4PFamil
y.xml. 

Open the ConvDerecho4PFamily.xml bundle in the Localization 
Perspective.  By inspection, you should be able to see that the 4-
panel product has this structure: 
 
<bundle> 

<displayList> 
<displays…..>     [Top Left Panel] 

<descriptor xsi:type=”mapDescriptor”> 
<resource>      
</resource> 
<resource> 
</resource> 
<timeMatcher … /> 
<numberOfFrames>  
</numberOfFrames> 

</descriptor> 
</displays> 
<displays…..>  [Top Right Panel] 

<descriptor xsi:type=”mapDescriptor”> 
<resource>      
</resource> 
<resource> 
</resource> 
<timeMatcher … /> 
<numberOfFrames>  
</numberOfFrames> 

</descriptor> 
</displays> 
<displays…..>  [Bottom Left Panel] 
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<descriptor xsi:type=”mapDescriptor”> 
<resource>      
</resource> 
<resource> 
</resource> 
<timeMatcher … /> 
<numberOfFrames>  
</numberOfFrames> 

</descriptor> 
</displays> 
<displays…..>  [Bottom Right Panel] 

<descriptor xsi:type=”mapDescriptor”> 
<resource>      
</resource> 
<resource> 
</resource> 
<timeMatcher … /> 
<numberOfFrames>  
</numberOfFrames> 

</descriptor> 
</displays> 

</displayList> 
</bundle> 
 
So for each panel (display), we’ll simply modify the resources for 
each display layer as we’ve done before. 

49. Analyze the Derecho 
Family in the virtual 
field table (Figure 22). 

The first panel is relatively simple, with an image and contours of 
bulk shear magnitude and a bulk shear vector plot.   
 
The second panel requires a firstAvailableResourceData for the 850-
300 MB muCape and Surface PBE.  The remaining plots for the 
second panel are simple.  However, note that ML doesn’t work with 
OB13.5.1, so we will substitute 0-1km FHAG for the ML references 
for the cCape and cCin contour plots. 
 
In addition to the simple surface precipitation, msl-P, and wind plots, 
the third panel has a three-way alternative for dew point (boundary 
layer, surface, or ML).  The three-way alternative will utilize 
firstAvailableResourceData, and will substitute 0-1km FHAG for ML. 
 
The fourth panel has wind plots for 6-10 km Agl.   
 
This model family has two unusual levels (850MB-300MB, and 6-10 
km Agl).  The levels and planes are defined in the volume browser’s 
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LevelMappingFile.xml, which can be viewed and overridden in the 
Localization Perspective (it’s under D2D » Volume Browser). The 
850MB-300MB plot is defined in the BASE version of 
LevelMappingFile.xml but the 6-10 km Agl level is not, so we’ll 
illustrate the process of adding a custom level while constructing the 
fourth panel. 
 
Note:  The ordering of the four panels is different between AWIPS-1 
and AWIPS-2.  AWIPS-1 is consistent in that the four panels are 
constructed and referenced (for example, by the “Panel Combo 
Rotate” function by pressing the number keys) in a clockwise order: 
 

1 2  BlkMag… muCape… 
4 3  TP… wSp… 

 
In the AWIPS-2 bundles, the panels are defined in the order shown 
in the previous step.  So if you translate a four panel virtual field 
table into a bundle without doing any re-ordering, the Derecho 
Family (Figure 22) would appear in this order (as is done in this 
exercise) where the bottom panels are reversed: 
 

BlkMag… muCape… 
wSp… TP… 

 
If you want four-panel families to be exactly replicated between 
AWIPS-1 and AWIPS-2, then you will need to use the third pane 
defined in the virtual field table as the fourth display in the AWIPS-2 
bundle  and the fourth virtual field table pane as the third AWIPS-2 
bundle display.   
 
By the way, the panel combo rotate function in AWIPS-2 references 
the panels in the same order as AWIPS-1. 
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Figure 22.  Excerpt of the virtual field table that defines the Conv: Derecho Family.  The interpretation of 
the numeric codes preceding each field and level combination is as follows:  A non-zero value in the ones 
place means this overlay should be toggled on by default. The tens digit is the display type to use: 
0=contour, 1=icons, 2=image, 3=barbs, 4=streamlines, 5=arrows, 6=dualarrows, 7=other. A non-zero 
value in the hundreds digit means start a new pane. The thousands place is number of frames to load; 0 
means the same as the number of forecast times and 99 means whatever the display is currently set for 
(verbatim from AWIPS-1 documentation in /awips/fxa/data/localization/documentation/families.html). 

50. Construct the first 
panel, the 0-10km Agl 
bulk shear plots. 

Edit the USER version of the ConvDerecho4PFamily.xml bundle in 
the Localization Perspective.  The first pre-existing resource for the 
first display is a 500 MB AV image.  We’ll transform the 500 MB AV 
image into the 0-10km bulk shear magnitude image.  Make these 
changes to the 500 MB AV resource: 

• Verify that the displayType = “IMAGE”, 
renderingOrderId=“IMAGE_REGION”, and isVisible=“true”. 

• Change the constraintValue for the 
info.parameter.abbreviation from “AV” to “BlkMag” 

• Change the constraintValue for the 
info.level.masterLevel.name from “MB” to “FHAG” 

• Change the constraintValue for the info.level.levelonevalue 
from “500.0” to “0.0” 

• Change the constraintValue for the info.level.leveltwovalue 
from “-999999” to “10000.0” 

Use the next pre-existing resource (500 MB GH contours) for the 0-
10 km BlkMag contours.  Make these changes to the 500 MB GH 
resource: 

• Verify that the displayType = “CONTOUR” 
• Change isVisible to “false” 
• Change the constraintValue for the 

info.parameter.abbreviation from “GH” to “BlkMag” 
• Change the constraintValue for the 

info.level.masterLevel.name from “MB” to “FHAG” 
• Change the constraintValue for the info.level.levelonevalue 

from “500.0” to “0.0” 
• Change the constraintValue for the info.level.leveltwovalue 

from “-999999” to “10000.0” 
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Using copy/paste, duplicate the new 0-10 km BlkMag contour plot. 
(Note the closing </resource> tag is just before the <timeMatcher> 
tag.) 
 
Use the second version for the BlkShr vector plot by making these 
changes: 

• Change the displayType = “ARROW” 
• Change isVisible to “true” 
• Change the constraintValue for the 

info.parameter.abbreviation from “BlkMag” to “BlkShr” 
51. Test.  The upper-left 

pane is shown, using 
the “panel combo 
rotate” function by 
pressing the “1” key. 

 
52. Construct the second 

panel, the CAPE and 
CIN plots. 

The first pre-existing resource for the second display is an image for 
1000-500 MB thickness (dz).  Transform this resource into visible 
contours of 0-6km muCape by making these changes: 

• Change the displayType to “CONTOUR” and 
renderingOrderId to “CONTOUR”. 

• Verify isVisible=“true”. 
• Change the constraintValue for the 

info.parameter.abbreviation from “dZ” to “muCape” 
• Change the constraintValue for the 

info.level.masterLevel.name from “MB” to “FHAG” 
• Change the constraintValue for the info.level.levelonevalue 

from “1000.0” to “0.0” 
• Change the constraintValue for the info.level. 

leveltwovalue from “500.0” to “6000.0” 
Remove the line that begins <capability 
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xsi:type=“imagingCapability”.  
This prevents the Imaging 
contextual menu from being 
available to allow a user to 
attempt to change the color 
palette for a contour plot 
(which obviously doesn’t make 
sense and would eventually 
generate a 
nullPointerException error). 
 
Replace the imagingCapability line with the outlineCapability line 
(copy/paste from a previous resource): 
<capability xsi:type=”outlineCapability” lineStyle=”SOLID” outlineOn=”true” outlineWidth=”1” />  

 
The second plot in this display, toggled off by default, has to choose 
between 850-300 mb muCape (most unstable CAPE) and surface PBE 
(positive buoyant energy), so it needs a resource with 
firstAvailableResourceData.  Add the lines indicated by the red box 
in Figure 23 to begin the firstAvailableResourceData.  Note this 
version of the firstAvailableResourceData includes properties to 
make the plots not visible. 
 
Indent the next resource (msl-P) using the Source menu and the 
Shift Right option, also shown in Figure 23. 
 
Make these changes to the msl-P resource: 

• Change isVisible to “false”. 
• Change the constraintValue for the 

info.parameter.abbreviation from “msl-P” to “muCape” 
• Change the constraintValue for the 

info.level.masterLevel.name from “SFC” to “MB” 
• Change the constraintValue for the info.level.levelonevalue 

from “0.0” to “850.0” 
• Add a mapping for info.level.leveltwovalue and set the 

constraintValue to “300.0” 
 

To make the surface PBE plot, duplicate the entire 850-300 MB 
muCape resource by copying and pasting it.  Make these changes to 
the second version: 

• Change the constraintValue for the 
info.parameter.abbreviation from “muCape” to “PBE” 

• Change the constraintValue for the 
info.level.masterLevel.name from “MB” to “SFC” 
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• Change the constraintValue for the info.level.levelonevalue 
from “850.0” to “0.0” 

• Change the constraintValue for the info.level.leveltwovalue 
from “300.0” to “-999999” 

 
Add two lines to close the firstAvailableResourceData between the 
closing </resource> tag of the PBE plot and the <timeMatcher> tag: 
     </resourceData> 
</resource> 
The next plot, ML cCape (computed CAPE for the mixed layer) needs 
only a simple resource.  Copy the PBE resource (don’t include the 
last </resourceData> and </resource> tags that close out the 
firstAvailableResourceData resource).  Paste it just before the 
<timeMatcher> tag (or just beneath the </resourceData> and 
</resource> tags that close out the firstAvailableResourceData). Use 
the second copy for the cCape resource by making these changes: 

• Unindent the resource 
• Change the constraintValue for the 

info.parameter.abbreviation from “PBE” to “cCape” 
• Change the constraintValue for the 

info.level.masterLevel.name from “SFC” to “FHAG” (we’re 
using 0-1km AGL rather than ML). 

• Verify the constraintValue for the info.level.levelonevalue is 
“0.0” 

• Change the constraintValue for the info.level.leveltwovalue 
from “-999999” to “1000.0” 

Duplicate the entire cCape resource to use for the next cCin 
(computed Convective Inhibition) plot.  Make this change to the 
second version: 

• Change the constraintValue for the 
info.parameter.abbreviation from “cCape” to “cCin”. 

Duplicate the cCin plot to use for the surface cCin plot.  Make these 
changes to the last version: 

• Change the constraintValue for the 
info.level.masterLevel.name from “FHAG” to “SFC” 

• Verify the constraintValue for the info.level.levelonevalue is 
“0.0” 

• Change the constraintValue for the info.level.leveltwovalue 
from “1000.0” to “-999999” 

Duplicate the surface cCin plot to use for the NBE plot.  Make this 
change to the second version: 

• Change the constraintValue for the 
info.parameter.abbreviation from “cCin” to “NBE” 



CAVE/EDEX Step-By-Step Exercises Exercise 9: Custom Model Families  148 

 
Figure 23.  Additions to the second display to start the firstAvailableResourceData for 850-300MB 
muCape/surface PBE. 
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53. Test.  The upper-right 
pane is shown, using 
the “panel combo 
rotate” function by 
pressing the “2” key, 
and toggling all the 
invisible contour 
plots. 

 
54. Construct the third 

panel, the surface 
precip, msl-P, and 
wind plots and the 
dewpoint plots for 
either the boundary 
layer, surface, or 
mixed layer 
(substituting 0-1km 
FHAG for the mixed 
layer). 

 
Note:  This display is in 
the lower left panel.  If 
an exact replication of 
the AWIPS-1 display is 
desired, then swap the 
third and fourth 
displays in the bundle 
after you complete 
editing them following 
this exercise. 

The first pre-existing resource in the third display is a ${TP} image 
(i.e., it uses whatever total precipitation field is passed into it from 
the menu making it model-specific).  We need to transform it to a 
visible contour.  Make these changes to this resource: 

• Change the displayType to “CONTOUR” and 
renderingOrderId to “CONTOUR”. 

• Change the imagingCapability to the outlineCapability as 
shown in Step 52. 

 
The next resource already in the bundle is a visible contour of 700 
MB PVV.  We need it to be visible contours of msl-P, so make these 
changes to it: 

• Change the constraintValue for the 
info.parameter.abbreviation from “PVV” to “msl-P” 

• Change the constraintValue for the 
info.level.masterLevel.name from “MB” to “SFC” 

• Change the constraintValue for the info.level.levelonevalue 
from “700.0” to “0.0” 

• Verify the constraintValue for the info.level.leveltwovalue 
is“-999999”, isVisible is “true”, and displayType is 
“CONTOUR”. 

Copy and paste the msl-P resource we just edited and use the 
second version as the surface wind barb plot. 
Make these changes to the second msl-P resource: 

• Change displayType from “CONTOUR” to “BARB” 
• Verify isVisible remains “true” 
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• Change the constraintValue for the 
info.parameter.abbreviation from “msl-P” to “Wind” 

The remainder of the metadata should retain the settings for the 
surface. 
The next resource needs to be the firstAvailableResource for the 
dewpoint plot chosen between three alternatives. 
 
Copy and paste the entire resource that contains the 
firstAvailableResourceData that we used in the second display for 
the muCape/PBE to use a starting point for the modifications we 
need to make here.   
 
In the first embedded resource (muCape), make these changes: 

• Change the constraintValue for the 
info.parameter.abbreviation from “muCape” to “DpT” 

• Change the constraintValue for the 
info.level.masterLevel.name from “MB” to “BL” 

• Change the constraintValue for the info.level.levelonevalue 
from “850.0” to “0.0” 

• Change the constraintValue for the info.level.leveltwovalue 
to “30”. 

 
In the second embedded resource (PBE), make these changes: 

• Change the constraintValue for the 
info.parameter.abbreviation from “PBE” to “DpT” 

• Verify the constraintValue for the 
info.level.masterLevel.name is “SFC”. 

• Verify the constraintValue for the info.level.levelonevalue is 
“0.0” 

• Verify the constraintValue for the info.level.leveltwovalue is 
“-999999”. 

 
Copy and paste the second resource to make a third dewpoint 
resource.  Be sure the last </resourceData> and </resource> tags 
that close out the firstAvailableResourceData are after the 
</resource> tag for the third dewpoint resource. Make these 
changes to the third resource: 

• Change the constraintValue for the 
info.level.masterLevel.name from “SFC” to “FHAG” 

• The constraintValue for the info.level.levelonevalue should 
remain “0.0” 

• Change the constraintValue for the info.level.leveltwovalue 
from  “-999999” to “1000.0”. 
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Add a colorableCapability to each of the three embedded dewpoint 
plots.  Set the colorAsString to “OrangeRed”. 
The last plot in this display is an image version of the dewpoint plot.  
Copy and paste the entire firstAvailableResourceData for the 
dewpoint plot.  In the second version, change all four instances of 
isVisible to “true”, all three instances of displayType from 
“CONTOUR” to “IMAGE”.  Remove the renderingOrderId tag from 
the container resource, but change the remaining three instances of 
renderingOrderId from “CONTOUR” to “IMAGE_REGION”.  Change 
the colorAsString in the three colorableCapability lines to 
“dodgerblue”.  Replace the outlineCapability lines with 
imagingCapability lines. 
 
Note:  the four instances of some of these tags come from the three 
embedded plots plus the firstAvailableResourceData itself. 

55. Test.  The lower-left 
pane is shown, using 
the “panel combo 
rotate” function by 
pressing the “4” key, 
and toggling all the 
invisible contour 
plots. 
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56. Construct the fourth 
panel, which consists 
of three wind plots.  
The first two plots are 
wind speed contours 
and image but for a 
custom layer (6-10 km 
Agl).  This new layer 
has to be specified in 
a user override of the 
volume browser 
customization file 
called 
LevelMappingFile.xml. 

 

In the Localization Perspective 
File Browser, scroll down to the 
D2D section.  Open Volume 
Browser » LevelMappingFile.xml.  
Right-click the BASE icon and 
choose  
Copy To ►User.   

Edit the LevelMappingFile.xml by double-clicking its USER icon.  Find 
the LYRFHAG section by searching the file for LYRFHAG (use CTRL-F). 
 
Add the lines indicated by the red box in Figure 24, and save your 
changes. 
Continue editing the USER version of the ConvDerecho4PFamily.xml 
bundle.  The first resource in the last display is a 1000-500 MB RH 
image.  Make these changes to this resource: 

• Verify the displayType is “IMAGE” 
• Verify the renderingOrderId is “IMAGE_REGION” 
• Change the constraintValue for the 

info.parameter.abbreviation from “RH” to “wSp” 
• Change the constraintValue for the 

info.level.masterLevel.name from “MB” to “LYRFHAG” 
• Change the constraintValue for the info.level.levelonevalue 

from “1000.0” to “6000.0” 
• Change the constraintValue for the info.level.leveltwovalue 

from “500.0” to “10000.0”. 
 
The second resource in the last display is 700 MB GH.  Transform this 
resource into 6-10km AGL wind speed contours with these edits: 

• Change the constraintValue for the 
info.parameter.abbreviation from “GH” to “wSp” 

• Change the constraintValue for the 
info.level.masterLevel.name from “MB” to “LYRFHAG” 

• Change the constraintValue for the info.level.levelonevalue 
from “700.0” to “6000.0” 

• Change the constraintValue for the info.level.leveltwovalue 
from “-999999” to “10000.0”. 

• Set isVisible to “false”. 
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Duplicate the last resource (the 6-10 km wind speed contours we 
just edited) to use for the wind vector plot.  Make these changes to 
the last resource: 

• Change the displayType to “ARROW” 
• Change the constraintValue for the 

info.parameter.abbreviation from “wSp” to “Wind” 
• Set isVisible to “true” 

 
Save your changes. 

 
Figure 24.  Edit to LevelMappingFile.xml to add 6-10 km Fixed Height Above Ground level. 

57. Restart CAVE to test.  
A restart is necessary 
because we modified 
the level mapping file. 

 
The lower-right pane is 
shown, using the “panel 
combo rotate” function 
by pressing the “3” key, 
and toggling the 
invisible contour plot. 

 



CAVE/EDEX Step-By-Step Exercises Exercise 9: Custom Model Families  154 

Part 7:  Add the menu for the Demo: Layers Family 
58. Use the 

briefingFamilies.xml 
menu as a template 
for the Demo: Layer 
Families menu and 
call the new version 
demoLayerFamilies.x
ml. Change the 
bundle references in 
this new 
demoLayerFamilies.x
ml to be appropriate 
for the Demo Layer 
Families Menu. 

In the Localization Perspective file 
browser, open CAVE » Menus » 
volume.  Copy 
briefingFamilies.xml to 
demoLayerFamilies.xml, by 
clicking the USER icon under 
briefingFamilies.xml and choosing  
Copy To ►New File.  Name the 
new file demoLayerFamilies.xml.   
 
We’ll change the bundle references next. 
 
Edit demoLayerFamilies.xml and change the name of the file for 
each bundleItem from BriefingFamily.xml to DemoLayerFamily.xml 
(see Figure 25). 
 
Save your changes. 
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Figure 25.  Changes to the DemoLayerFamilies.xml menu file. 

59. Edit the index.xml 
menu file to create 
the demo layer model 
family entry above 
the Surface Families 
entry.   

Edit the user version of index.xml by double-clicking its USER icon. 
 
Add the lines indicated by the red box in Figure 26. 
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Figure 26.  Additions to index.xml menu file to add an entry for Demo: Layer Families entry. 

60. Duplicate the 
BriefingFamily.xml 
bundle file as 
DemoLayerFamily.xml, 
so that the menu 
entries created above 
will work. 

In the File Browser, scroll to the 
CAVE » Bundles section.   Open 
volume » BriefingFamily.xml.  
Right-click the USER icon and 
choose Copy To ►New File.  
Name the new file 
DemoLayerFamily.xml 
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61. Restart CAVE to see 
your changes 
reflected in the 
Volume menu.  The 
Demo: Layer Families 
menu should be 
located above Surface 
Families and should 
display the bundles  
referenced by the 
DemoLayerFamilies.x
ml menu file.  

Part 8.  Implement the Demo: Layer Families Bundle. 
62. Analyze the 

ModFamDM entry in 
the virtual field table 
(Figure 27).  Unlike 
other model families 
in this exercise, this 
bundle was not 
implemented in 
AWIPS-1 at a 
particular WFO, but 
was developed to 
illustrate several 
concepts in 
constructing bundles.  

This family includes an image combination and a variety of different 
model layers.  The image combination can be identified because two 
layers begin with the numeric code “21.”, meaning a combined 
visible image for both layers the height of the freezing level and 
surface precip accumulation (zAGL,FrzLvl and TP,Surface).  The 
image combination in AWIPS-2 is implemented using  
blendedResourceData. 
 
Note:  AWIPS-1 required two images in the same model family (or 
procedure bundle) to be combined.  AWIPS-2 has no such 
requirement, so there can be any number of independent images 
with appropriate alpha channel (transparency) settings in a bundle. 
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Figure 27.  Virtual Field Table entry that defines the Demo: Layers family.  The interpretation of the 
numeric codes preceding each field and level combination is as follows:  A non-zero value in the ones 
place means this overlay should be toggled on by default. The tens digit is the display type to use: 
0=contour, 1=icons, 2=image, 3=barbs, 4=streamlines, 5=arrows, 6=dualarrows, 7=other. A non-zero 
value in the hundreds digit means start a new pane. The thousands place is number of frames to load; 0 
means the same as the number of forecast times and 99 means whatever the display is currently set for 
(verbatim from AWIPS-1 documentation in /awips/fxa/data/localization/documentation/families.html). 

63. Add the Haines Index 
as the first 
parameter. 

Edit the USER version of the DemoLayerFamily.xml bundle.  In the 
first resource, make these changes: 

• Change the constraintValue for the 
info.parameter.abbreviation from “TP” to “HI” 

• Change the constraintValue for the 
info.level.masterLevel.name from “SFC” to “EA” (EA means 
“Entire Atmosphere”). 

Verify the following settings in the first resource 
• isVisible is “false” 
• displayType is “CONTOUR” 
• info.level.levelonevalue is “0”  
• info.level.leveltwovalue is “-999999”. 

 
The info.level.masterLevel.name for a “layer” product is “EA”.  The 
names for the various layer or level types can be determined by 
inspecting the LevelMappingFile.xml. 

64.  Add the combined 
image pair for the 
height of the freezing 
level and total 
precipitation. 

The image combination requires the use of a blendedResourceData.  
It is similar in structure to a firstAvailableResourceData (which 
happens to be the next pre-existing resource in the 
DemoLayerFamily.xml bundle).  The structure is:  
<resource> 

<loadProperties> 
       <capabilities> 
             <capability … /> 
       </capabilities> 
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</loadProperties> 
<properties …>  </properties> 
<resourceData xsi:type=”blendedResourceData”> 

<resource>            (first image) 
</resource> 
<resource>            (second image) 
</resource> 

</resourceData> 
</resource> 
 
To start the transformation of our firstAvailableResourceData to a 
blendedResourceData, replace the three loadProperties, properties, 
and resourceData lines with the lines indicated in Figure 28. 
 
In the first pre-existing resource (msl-P) of the 
blendedResourceData, replace the two existing capabilities (the 
outlineCapability and the colorableCapability) with the three 
capabilities shown in the red box in Figure 29. 
 
Remove the xsi:type and displayType from the loadProperties (Box A 
in Figure 29). 
 
Add the renderingOrderId=“IMAGE_REGION” (Box B in Figure 29). 
 
Set the info.parameter.abbreviation constraintValue to “zAGL” (Box 
C in Figure 29). 
 
Set the info.level.masterLevel.name constraintValue to “FRZ” (Box D 
in Figure 29) for the freezing level.  Make sure the levelonevalue is 0. 
 
Use Copy/Paste to duplicate the entire zAGL resource (we’re re-
using the first resource to avoid retyping the edits to the capability 
lines in the second resource; otherwise we would have used the next 
pre-existing resource) .  In the second version, change the 
parameter.abbreviation from zAGL to TP, and the 
info.level.masterLevel.name from “FRZ” to “SFC”.   
 
Close the blendedResourceData by adding the two lines after the 
second (TP) resource: 
    </resourceData> 
</resource>  
 
Delete the next resource and the </resourceData> and </resource> 
tags that previously closed out the firstAvailableResourceData. 
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Figure 28.  Edits to start a blendedResourceData. 
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Figure 29.  Edits to the first image resource within the blendedResourceData. 

65. Test 

 
66.  Make the next 

resource be the 

visible contour plot 
for the height of the 

The next resource already in the DemoLayerFamily.xml bundle 
contains a firstAvailableResourceData for an icon plot for PTyp and 
Snow3. Delete the four lines that started the 
firstAvailableResourceData (<resource>, <loadProperties/>, 
<properties isVisible=”false”>, and <resourceData 
xsi:type=”firstAvailableResourceData>”  Unindent the next (PTyp) 
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freezing level zAGL.  resoure and make these changes: 
• displayType from “ICON” to “CONTOUR” 
• isVisible to “true” 
• info.parameter.abbreviation from “PTyp” to “zAGL” 
• info.level.masterLevel.name from “SFC” to “FRZ”. 

Also, delete the colorableCapability line.   
 
Delete the next (indented) resource that was previously for the 
second half of the firstAvailableResourceData (the Snow3 
parameter).  Delete the closing </resourceData> and </resource> 
tags that were associated with the firstAvailableResourceData.   

67.  The next resource 
needed should 
contain a 
firstAvailableResource
Data for either the 
height of the cloud 
base or the lifted 
condensation level.    

The next resource already in the bundle had a 
firstAvailableResourceData for PTyp and Fzra2.  We’ll hijack it for this 
plot.  
 
In the first (PTyp) resource, change the displayType from “ICON” to 
“CONTOUR.  Leave the colorAsString in the colorableCapability as 
“burlywood”.   
 
In the first resource of the firstAvailableResourceData , use these 
settings for the metadata: 

• info.parameter.abbreviation:  zAGL 
• info.level.leveltwovalue: -999999 
• info.level.masterLevel.name:  CBL 
• info.level.levelonevalue: 0 

 
In the second resource of the firstAvailableResourceData, set the 
displayType to “CONTOUR” and  use these settings for the metadata: 

• info.parameter.abbreviation:  zAGL 
• info.level.leveltwovalue: -999999 
• info.level.masterLevel.name:  LCL 
• info.level.levelonevalue: 0 

 
68. The next resource 

needs to be a 
firstAvailableResource
Data for two wind 
barb plots, either for 
boundary layer winds 
or the surface. 

The next pre-existing resource is the icon plot for PTyp and Mix2 at 
the surface.  We’ll reuse it for this wind barb plot. 
 

• In the first embedded resource: 
o change the displayType to “BARB” 
o change info.parameter.abbreviation to Wind 
o change info.level.masterLevel.name to “BL” 
o verify info.level.levelonevalue is  0.0 
o change info.level.leveltwovalue to  30.0 

• In the second resource: 
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o change the displayType to “BARB” 
o change info.parameter.abbreviation to Wind 
o change info.level.masterLevel.name to “SFC” 
o verify info.level.levelonevalue is  0.0 

69. Test  (Note that the 
cloud base level is 
available from the 
RAP model) 

 

 
70. Add the next three 

layers, which are all 
on Potential Vorticity 
surfaces (the 1.5 
surface).  The three 
plots are two visible 
contours of Pressure 
and Pressure 

The next three layers are all simple resources, but are all on a 
potential vorticity surface.  The particular coordinate we need to use 
is “PV15”.  The next pre-existing resource in the file has a 
firstAvailableResourceData to choose between PTyp or Rain3.  
Delete that entire resource.  The next resource after that is a simple 
resource for wind barbs, and we’ll use it for the pressure contour 
plot.  Make these changes to that resource: 

• displayType: “CONTOUR” 
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Advection separated 
by a visible plot of 
streamlines. 

 

• info.parameter.abbreviation: “P” 
• info.level.masterLevel.name: “PV” 
• info.level.levelonevalue: “1.5” 
• info.level.leveltwovalue:  “-999999” 

 
Delete the entirety of the next firstAvailableResourceData which 
should have been for either DivFn or qDiv.  The next resource after 
that was for a contour plot of 850 mb Moisture Transport Magnitude 
(Mmag).  We’ll use that for the streamline plot.  Make these 
changes: 

• displayType: “STREAMLINE” 
• isVisible: “true” 
• info.parameter.abbreviation: “Wind” 
• info.level.masterLevel.name: “PV” 
• info.level.levelonevalue: “1.5” 
• info.level.leveltwovalue:  “-999999” 

Transform the next resource (850 MB Moisture Transport Vectors, 
or MTV) into the pressure advection contours with these changes: 

• displayType: “CONTOUR” 
• isVisible: “false” 
• info.parameter.abbreviation: “PAdv” 
• info.level.masterLevel.name: “PV” 
• info.level.levelonevalue: “1.5” 
• info.level.leveltwovalue:  “-999999” 

 
71. Test 
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72. Add cCape for 0-6km 
Agl. 

In the next resource, use these settings: 
• displayType: CONTOUR 
• isVisible: false 
• info.parameter.abbreviation:  cCape 
• info.level.masterLevel.name:  FHAG 
• info.level.levelonevalue: 0 
• info.level.leveltwovalue: 6000 

 
73. Add BlkShr arrows for 

1-3km AGL 
In the next resource, use these settings: 

• displayType: ARROW 
• isVisible: false 
• info.parameter.abbreviation:  BlkShr 
• info.level.masterLevel.name:  LYRFHAG 
• info.level.levelonevalue: 1000 
• info.level.leveltwovalue: 3000 

 
74. Test 

 
75. Add the dew point  

for the 305Ke surface. 
In the next resource, use these settings: 

• displayType: CONTOUR 
• isVisible: false 
• info.parameter.abbreviation:  DpT 
• info.level.masterLevel.name:  Ke 
• info.level.levelonevalue: 305 
• info.level.leveltwovalue: -999999 

 
Note:  The 305Ke surface is not a default/baseline Ke (equivalent 
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potential temperature) level.  This level needs to be added to the 
level mapping file (described later). 
 
Delete the next pre-existing resource with the 
firstAvailableResourceData. 

76. Add the DpT for the 
330 K (potential 
temperature) surface 

In the next simple resource, use these settings: 
• displayType: CONTOUR 
• isVisible: false 
• info.parameter.abbreviation:  DpT 
• info.level.masterLevel.name:  K 
• info.level.levelonevalue: 330 
• info.level.leveltwovalue: -999999 

 
77. Edit the level mapping 

file to add the 305Ke 
level. 

Edit the USER version of the LevelMappingFile.xml (it’s under D2D » 
VolumeBrowser in the File Browser).  If you completed Part 6 of this 
exercise to add the Conv: Derecho Family, you already completed a 
similar edit and created a USER version of this file.  If you  haven’t 
already created a USER version of this file, refer to that part of the 
exercise. 
Add the lines indicated in Figure 30. 
 
Delete the remaining resources in the bundle (1000-500 mb RH, 500 
MB AV/geoVort, 500-300 mb PTvA, 300/250 mb wSp, 300/250 mb 
streamlines, 300/250 mb wDiv) 
 
 Save your changes. 
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Figure 30.  Edit to LevelMappingFile.xml to add the 305Ke level. 

78. Restart CAVE 
(because we modified 
the level mapping file) 
and Test.  Depending 
on the time of year, 
the dew point plot for 
the 305Ke surface 
may appear only at 
very northern 
latitudes. 
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Part 9.  For Further Practice:  Implement the Aviation Fog Family Menu and Bundle 
79. Edit the index.xml 

menu file to create 
the Aviation Fog 
model family entry 
just before the 
Surface Families 
entry. 

In the Localization Perspective file browser, open CAVE » Menus » 
volume.  Edit the user version of index.xml by double-clicking its 
USER icon. Make the bottom of the file look like Figure 31. 
 

 
 
Figure 31.  Menu contribution to add the Aviation Fog Family. 
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80. Use the 
briefingFamilies.xml 
as a template for the 
Other: Aviation Fog 
Families menu. 
Change the bundle 
references in the new 
aviationFogFamilies.x
ml to be appropriate 
for the Aviation Fog 
Families Menu. 

Copy briefingFamilies.xml to 
aviationFogFamilies.xml, by 
clicking the USER icon under 
briefingFamilies.xml and 
choosing Copy To ►New File.  
Name the new file 
aviationFogFamilies.xml.   
 
We’ll change the bundle 
references next. 
Edit aviationFogFamilies.xml and change the name of the file for 
each bundleItem from BriefingFamily.xml to AviationFogFamily.xml 
(see Figure 32). Save your changes. 

 
Figure 32.  Menu entries for the Aviation Fog family. 
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81. Restart CAVE to see 
your changes 
reflected in the 
Volume menu.  The 
Other: Aviation Fog 
Families menu should 
be located above 
Surface Families and 
should display the 
models declared in 
the 
aviationFogFamilies.x
ml file. 

 

82. Create the 
AviationFogFamily.x
ml bundle.   

As an exercise on your own, implement the model family shown in 
Figure 33.  So you can check your work, the resulting bundle is 
attached to this exercise. 
 
The excerpt of the virtual field table in Figure 33 indicates this is a 
four-panel family (because the numeric codes have three digits).   
 
The first panel has visible contours of geopotential height at 400 and 
700 mb plus two visible images of relative humidity at 400 and 700 
mb.  Because two images are visible, an image combination is also 
required.  The first panel also has contours of RH at 400 and 700 mb 
that are not initially visible. 
 
The second panel has contours and an image of vertical velocity at 
700 mb. 
 
The third panel has visible contours of sea-level pressure and wind 
barbs at the surface. 
 
The fourth panel has visible wind barbs representing boundary layer 
winds plus a visible image of boundary layer RH and contours of 
boundary layer RH that are not initially visible. 
 

 
Figure 33.  AWIPS-1 virtual field table entry for the Aviation Fog 4-panel Family. 
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Exercise 10:  AWIPS-1 SKEWT_TMIN Directive — Altering Temperature Axis of SKEW-T plots 
 

Objectives:  In this exercise, you will perform this procedure: 

• Customize the NSHARP sounding display to shift the temperature axis on a skew-t plot. 

Background.  AWIPS-1 had a directive called “SKEWT_TMIN” that was set in a site’s LLL-
mainConfig.txt file.  This directive allowed the site to set the temperature of the lower-left 
corner of the skew-t plot.  The default temperature for the lower-left corner of the skew-t 
diagram in AWIPS-1 was -36.6°C, but sites could alter it for their climatic regimes, effectively 
shifting the sounding left or right on the diagram.   For example, very warm sites set this value 
to -28°C, while several sites in Alaska set this value to -48°C. 

 

In earlier versions of AWIPS-2, the ability to set this value (as an offset, 
rather than an absolute value) was moved to a soundingPrefs.xml file.  
Subsequently, the NSHARP GUI allows the user to configure the offset 
value and to save it.  The GUI saves the offset value as a “tempOffset” 
value in a <graphProperty/> tag near the top of a nsharpConfig.xml file 
(Figure 1).  This file is located in the Localization Perspective under NCEP 
» Nsharp » nsharpConfig.xml.  If you wish to set a SITE default, then set a 
value for your user and promote your USER version of nsharpConfig.xml 
to SITE using the Localization Perspective (right-click on the USER icon and 
select Move To ►Site). 
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Figure 1.  Excerpt from nsharpConfig.xml with the tempOffset value highlighted.  This value shifts the temperature axis of the 
NSHARP skew-t plot left and right. 

The exact steps to perform this configuration are covered in a job sheet in the NSHARP 
overview that is packaged alongside the AWIPS-2 Variance Training.  Hence, these steps are not 
reproduced here.  Refer to Job Sheet 4 (“Configuring a Sounding Display”) and Task 2 
(“Configure the Wind Barb Density and Temperature Range Offset”) for specific and simple 
instructions. 
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Exercise 11:  Customizing the Pop-up Skew-T and the Standard Environmental Data Package 
and Volume Browser to Include a Local Model

 

Objectives:  In this exercise, you will perform these procedures: 

• Add a local model as a choice to sample with the Pop-up Skew-T 
• Add a local model to the Standard Environmental Data Package 
• Add a custom parameter to sample using the Standard Environmental Data Package 
• Add the custom model to the Volume Browser 

Background.  Once AWIPS-2 has been configured to recognize and ingest a local model, this 
model can be viewed and sampled using the Pop-up Skew-T and the Standard Environmental 
Data Package.  The Pop-Up Skew-T allows model profiles to be sampled alongside a model grid 
as well as radar and satellite imagery.   The Standard Environmental Data Package allows model 
parameters to be sampled along the tilt or slant range of a radar.  The baseline AWIPS 
configurations for the Pop-Up Skew-T and the Standard Environmental Data Package include 
these models: 
 

 

 

 

Pop-Up Skew-T Standard Environmental 
Data Package 

NAM LAPS 

GFS 212 NAM40 

RUC RAP40 

LAPS NAM12 

Raobs GFS40 

RAP13 

RaobOA 
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This exercise assumes you’ve already configured 
AWIPS-2 to accept a local model according to the 
“Site Migration Guide” available on the AWIPS One 
Stop Shop web site.  Additional details for adding local 
models are given in the “AddLocalGrib.pdf” file that’s 
included under “Additional Resources” alongside the 
Site Migration Guide on the One Stop Shop (as of 
September 2013).  One of the consequences of 
following these instructions is the production of a 
model identification .XML file in 
edex_static/site/{SITE}/grib/models
(a sample is shown at the right).  
The examples given in this exercise 
are for a version of the WRF model 
(given the model name ID 
“OUNWRF”), so where “OUNWRF” 
appears in the examples, you would 
substitute the ID of your own local 
model. 

Adding the new model to the Pop-
Up Skew-T requires customizing the 
values.xml file under D2D » Cloud 
Height in the Localization 
Perspective.   The menu and display 
bundles for the Standard 
Environmental Data Package are 
modified to include a new model 
and custom parameter, respectively.  Finally, adding the model to the volume browser involves 
an override to the vbSources.xml file.   The changes to each of these files are relatively simple.  

This exercise should take about 15-30 minutes to complete. 
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Concept Actions 

Part 1:  Add the local model to the Pop-Up Skew-T 
1. Make a site override 

for the values.xml file 
that’s part of the Cloud 
Height plugin.   
 
Note:  Your user must 
have site override 
permissions enabled in 
the userRoles.xml file.  
See Exercise 1 for 
more information. 

 

In the Localization 
Perspective file browser, 
open D2D » Cloud Height » 
values.xml. Make a site 
version by right-clicking the 
BASE icon and choosing 
Copy To ► Site.   
 

2. Add the local model to 
the SITE version of 
values.xml. 

Edit the SITE version of values.xml.  Add a line like the one 
indicated in Figure 1.  Remember to substitute the ID for your 
model in place of “OUNWRF”. The display name can contain 
spaces.  This is the text that appears in the Pop-Up Skew-T 
contextual menu, which allows the user to choose the model to be 
sampled.  
 
Save your changes. 

 
Figure 1.  Addition of a local model (OUNWRF) to the values.xml file to enable sampling with 
the Pop-Up Skew-T. 
3. Test the Pop-Up Skew-

T to verify the change. 
In the D2D perspective, load a 
radar or satellite image. 
 
Load the Pop-Up Skew-T by 
clicking on CAVE’s Volume 
menu then PopUp SkewT. 
 
Right-click somewhere in the 
radar or satellite image away 
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from the legend.  In the context menu that appears, click the 
Sample Cloud Heights/Radar Skew T pull-out menu and choose 
the new source. 
 
Right-click to get the contextual menu again and choose the 
Sample check box.  Roam around the image and examine the 
corresponding data in the Pop-Up Skew-T. 

Part 2:  Add the local model to the Standard Environmental Data Package 
4. Make a site override of 

the 
baseStdEnvPackage.xml 
menu for the Standard 
Environmental Data 
Package. 

In the Localization Perspective 
file browser, open CAVE » 
Menus » volume » 
baseStdEnvPackage.xml.  Make 
a site version by right-clicking 
the BASE icon and choosing 
Copy To ► Site.   
 

5. Edit the menu and add 
a menu entry for the 
new model. 
 

Edit the new SITE version of baseStdEnvPackage.xml.  Add a new 
menu entry similar to the change highlighted in Figure 2.  The most 
critical piece of information is the model ID used as the value tag 
for the model name.  Note we also changed the name of the 
bundle file the menu item references from DefaultStdEnv.xml to 
ounwrfStdEnv.xml.  This change can accommodate parameters 
your local model may have that standard models do not have.  
Save your changes. 
 
 

6. Copy the 
DefaultStdEnv.xml 
bundle to 
ounwrfStdEnv.xml. 

In the Localization 
Perspective file browser, 
open CAVE » Bundles » 
volume » 
DefaultStdEnv.xml.  Right-
click the BASE icon and 
choose Copy To ► New 
File.  Name the new file to 
whatever filename was used 
in Step 5.  In our case, it is 
ounwrfStdEnv.xml.   
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Figure 2.  Adding the local model to the Standard Environmental Data Package menu. 
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7. Test. Restart CAVE then load a radar 
image.  Then load the new model 
from the Standard Environmental 
Data Package (Volume » Std Env 
Data Package » New Model).  
Finally, enable sampling.  
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Part 3:  Add a custom parameter from the new model to the  
Standard Environmental Data Package 

8. Edit the 
ounwrfStdEnv.xml 
bundle that we just 
created.  It contains the 
default parameters in 
the Standard 
Environmental Data 
Package. 
 
Add a bundle resource 
for the custom 
parameter. In this case, 
we’ll add surface CAPE.   
 
The edits here are 
similar to those made 
in Exercise 9 for model 
families. 

In the Localization Perspective file browser, open CAVE » Bundles 
» volume » ounwrfStdEnv.xml.  Copy and paste the lines 
highlighted by the red box in Figure 3.  In the second version, make 
these changes: 

• Change the constraintValue for the parameter.abbreviation 
from P to CAPE (Box “A” in Figure 3). 

• Change the constraintValue for the 
info.level.masterLevel.name from “TILT” to “SFC” (Box “B” 
in Figure 3). 
 

 
Figure 3.  Edits to the ounwrfStdEnv.xml bundle to add a custom model parameter to the 
Standard Environmental Data Package readout.  The name of the bundle you edit is whatever 
you called it in Step 5. 
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9. Test. Load a radar image and the Standard Environmental Data Package 
as in Step 6.  Note the CAPE parameter displays in the cursor 
readout. 

Part 4:  Add the new model as a source for the Volume Browser 
10. The sources for the 

volume browser are 
configured using the 
VbSources.xml file.  
Make a site override 
of this file. 

In the Localization Perspective file browser, open D2D » Volume 
Browser » VbSources.xml.  Make a site 
version by right-clicking the BASE icon and 
choosing Copy To ► Site.   
 

11. Add a entry for the 
new model into 
VbSources.xml. 

Edit the SITE version of the VbSources.xml file.  Add an entry 
similar to the one highlighted in Figure 4.  It is critical that the key 
be the model ID for your local model. 
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Figure 4.  Additional entry in the VbSources.xml file to add a local model to the sources menu of 
the Volume Browser.   
 
Note:  Some WFOs have their local model under a Local menu in the Volume Browser.  In this 
case, the category should be “Local”. 
12. Restart CAVE and Test. Open the Volume Browser and ensure the new model is available 

from the Volume menu in the sources area and that you can load a 
product from the model using the volume browser. 
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Exercise 12:  Adding Custom Menu Entries to the Tools and Help Menus 
 

Objectives:  In this exercise, you will perform these procedures: 

• Add a custom menu entry to the Tools menu to execute an arbitrary command that is 
external to AWIPS-2 

• Add a custom menu entry to the Help menu to execute an arbitrary command that is 
external to AWIPS-2. 

Background.  AWIPS-1 had the ability to add custom 
menu entries to the Tools menu of D2D by editing a 
localAppsInfo.txt file located in $FXA_CUSTOMFILES.  
In AWIPS-2, custom menu entries are added by editing 
menu XML files in the localization perspective.  
 

This exercise demonstrates the procedure of adding 
additional menu entries to execute commands that are 
external to AWIPS-2 (that is, any command that could 
be executed using a command prompt).  The specific 
example given here is to access the AWIPS-2 Variance 
Training web page using the Firefox web browser.  For 
demonstration purposes, the same command is added 
to both the Tools menu and the Help menu.  A similar 
procedure would be followed allow CAVE to launch 
other external locally-developed applications.  In this exercise, two similar methods are used, 
one for the tools menu and the other for the help menu.  The difference between the two is 
that one method could prevent later baseline menu changes from being seen while the other 
allows both local changes and future baseline changes to be activated. 

This exercise should take about 5-10 minutes to complete. 
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Concept Actions 

1. Make a user override 
for the toolsindex.xml 
menu file.   
 

 

In the Localization Perspective 
file browser, open CAVE » 
Menus » tools » 
toolsindex.xml. Make a user 
version by right-clicking the 
BASE icon and choosing Copy 
To ► User.   
 

2. Make a new user-level 
menu file called 
trainMenu.xml using 
the 
baseToolsMenu.xml file 
as a template.  
 

Open 
baseToolsMenu.xml 
and right-click the BASE 
icon and choose Copy 
To ►New File.  Name 
the new file 
trainMenu.xml. 

3. Edit the new 
trainMenu.xml to 
delete the pre-existing 
entries and to add a 
new entry for the 
AWIPS-2 Variance 
Training web page. 

Edit the trainMenu.xml file by double-clicking its icon.   
 
Delete the existing menu contributions beginning with the one for 
the Az/Ran Overlay and ending with the one for the Vr – Shear 
tool.  
 
If you are performing this action on an ADAM platform, make the 
edit shown in Figure 1. 
 
If this is on a live AWIPS-2 system, make the change shown in 
Figure 2. 
 
Save your changes. 
 
Note that the baseline menu file includes a comment near the 
bottom of the file that documents the available options involved in 
adding an arbitrary command to a CAVE menu.  Additional menu 
contributions could be added as well as more structure, including 
submenus, if desired.  For examples of submenus, see Exercise 8. 
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Figure 1.  Edits to trainMenu.xml to add a command to launch the firefox web browser with the 
Variance Training web page (ADAM version) 

 
Figure 2.  Edits to trainMenu.xml to add a command to launch the firefox web browser with the 
Variance Training web page (live AWIPS-2 workstation version) 
4. Edit the toolsindex.xml  

menu to include the 
new trainMenu.xml. 

Edit your USER version of toolsindex.xml.  Add the new menu 
entry that is highlighted in Figure 3.  Save your changes. 

 
Figure 3.  Including the trainMenu.xml menu to the bottom of the D2D Tools Menu. 
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5. Restart CAVE and open 
the Tools menu to see 
the new menu entry 
and verify that it 
works. 
 
(Note: if Firefox is 
already open on your 
workstation, then the 
web page may open in 
a new tab in the 
existing Firefox 
instance).  

 
6. Make a new 

trainindex.xml file.  
Any menu file named 
according to 
*index.xml gets 
included into the menu 
structure so long as it 
references part of the 
existing structure.  
With the previous 
method, if a future 
baseline change to 
toolsindex.xml 
occurred, we would 
never see it because 
our USER or SITE 
override would 
prevent those changes 
from being reflected 
on our system.  This 
method does not 
consist of an override; 
rather, it just adds a 
new menu 
contribution.     

Right-click the USER version of 
the toolsindex.xml file (CAVE » 
Menus » tools » 
toolsindex.xml) and choose 
Copy To ►New File. Name the 
new file trainindex.xml.  Edit 
trainindex.xml so it reads like 
Figure 4. 
 
 
 
 
Note:  the help menu is not explicitly shown as a separate 
category in the Localization Perspective; it is defined elsewhere.  
Additionally, there is no recommended place to store a local 
menu contribution file.  One WFO made a localmenus directory 
to store such files.  This directory has to be manually created 
outside the Localization Perspective in 
cave_static/site/{Site}/menus/localmenus. 
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Figure 4.  Adding the trainMenu.xml to the bottom of the D2D Help Menu using a new 
trainindex.xml menu file rather than overriding an existing menu file.  
7. Restart CAVE and open 

the Help menu to see 
the new menu entry 
and verify that it works. 
 

 
8. If desired, promote 

your USER versions of 
toolsindex.xml and 
trainMenu.xml to SITE. 
 
Note:  Your user must 
have site override 
permissions enabled in 
the userRoles.xml file.  
See Exercise 1 for 
more information. 
 

Right-click the USER 
version of toolsindex.xml 
and choose  
Move To ►Site. 
 
Right-click the USER 
version of trainMenu.xml 
and choose  
Move To► Site. 
 
Right-click the USER version of trainindex.xml and choose  
Move To► Site. 
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Index 

Adaptive Plots, 13 
AWIPSII_AUTOMATION_TOOL.tgz, 25 

 
baseLocalRadarMenu.xml, 60 
baseRadarMenu.xml, 45 
blendedResourceData, 157 
boundary layer, 149 

 
cities.xml, 8 
cloud base level, 162 
Cloud Height plugin, 175 
colorableCapability, 95 
Comments in Localization Perspective, 95 
config.xml file in com.raytheon.viz.core, 95 
configured config level, 58 
CONUS.xml, 20 
cursor readout, 27, 39, 178, 180 

 
dbMapResourceData, 4 
dbPointMapResourceData, 8, 12 

 
equivalent potential temperature surface (Ke), 

165 
 

firstAvailableResourceData, 95, 104 
four-panel family, 138 
freezing level, 161 
FXA_CUSTOMFILES, 182 

 
gridResourceData, 104 

 
h5dump, 28 
Help menu, 182 

 
Icon plot, 109 
imagingCapability, 145 
importAdaptivePlot.py, 13 
importShapeFile.sh, 2 

 
LevelMappingFile.xml, 133, 142 
lifted condensation level, 162 
loadSpotters.py, 13 
local applications, 182 
localAppsInfo.txt, 182 

lpiResourceData, 8 
 

mainConfig.txt, 171 
metarHiWcDesign.svg, 29 
mixed layer, 129 
model levels, 93 
mosaicInfo.txt, 45 

 
nsharpConfig.xml, 171 

 
OAX localization, 47 

 
Panel Combo Rotate, 142 

 
pgadmin3, 5 
plot models, 27 
plotDelegate, 36, 40 
Plugin Configs, 95 
plugin.xml (plugins.com.raytheon.uf.viz.d2d.ui), 

94 
potential temperature surface (K), 166 
potential vorticity surface, 163 
product and legend colors, 95 
Product Info, 95 

 
radar_spatial table, 48 
radarsInUse.txt, 47 
renderingOrderId, 117 
rgb.txt, 95 

 
scalesInfo.xml, 19, 24 
setup.env, 45 
shapefile, 2 
SKEWT_TMIN directive, 171 
soundingPrefs.xml, 171 
spotters.dat, 14 
spotters.lpi, 18 
StationPlot.xml, 29 
StdObsDesign.svg, 36 
streamline plot, 122 

 
Tools menu, 182 
typecast, 11 
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User Shapefile, 2 
userRoles.xml, 4 

 
values.xml, 174 
vbSources.xml, 174 

vector plot, 135 
Virtual Field Table, 93 
virtualFieldTable.txt, 93, 98 

 
wind barbs, 37, 113 
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